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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).

iii



iv   Safety warning notice



Table of contents

1  Product description ........................................................................................................... 1

2  External component identification ................................................................................... 15

Display .................................................................................................................................  15
Buttons and fingerprint reader (select models only) .....................................................................  17
Keys .....................................................................................................................................  18
Lights .................................................................................................................................... 19
TouchPad .............................................................................................................................. 20
Front ..................................................................................................................................... 21
Left side ................................................................................................................................  22
Right side .............................................................................................................................. 23
Rear .....................................................................................................................................  24
Bottom ..................................................................................................................................  25

3  Illustrated parts catalog .................................................................................................. 27

Service tag ............................................................................................................................ 28
Computer major components ...................................................................................................  29
Display assembly subcomponents ............................................................................................. 40
Cable Kit ..............................................................................................................................  42
Plastics Kit .............................................................................................................................  43
Mass storage devices .............................................................................................................  44
Miscellaneous parts ................................................................................................................ 46
Sequential part number listing .................................................................................................. 47

4  Removal and replacement procedures ............................................................................ 61

Preliminary replacement requirements ....................................................................................... 61
Tools required ......................................................................................................... 61
Service considerations .............................................................................................  61

Plastic parts .............................................................................................  61
Cables and connectors .............................................................................  61
Drive handling .........................................................................................  62

v



Grounding guidelines ..............................................................................................  62
Electrostatic discharge damage .................................................................. 62

Packaging and transporting guidelines ........................................ 64
Component replacement procedures ........................................................................................ 66

Service tag ............................................................................................................. 66
Computer feet ......................................................................................................... 67
Battery ................................................................................................................... 68
SIM ....................................................................................................................... 69
Service cover .......................................................................................................... 70
Optical drive .......................................................................................................... 71
Upgrade bay .......................................................................................................... 73
Hard drive ............................................................................................................. 74
RTC battery ............................................................................................................ 76
Memory module ...................................................................................................... 77
WWAN module ..................................................................................................... 80
WLAN module ........................................................................................................ 82
Bluetooth module .................................................................................................... 84
Modem module ....................................................................................................... 85
Fan ....................................................................................................................... 87
Keyboard ............................................................................................................... 88
Base enclosure ........................................................................................................ 93
Speaker assembly ................................................................................................... 97
RJ-11 jack cable ...................................................................................................... 98
Service cover release latch assembly ......................................................................... 99
Battery release latch assembly ................................................................................ 102
Function board ..................................................................................................... 104
System board ....................................................................................................... 106
Heat sink .............................................................................................................. 111
Processor ............................................................................................................. 114
USB board ........................................................................................................... 117
Display assembly .................................................................................................. 119

5  Computer Setup (BIOS) and Advanced System Diagnostics ............................................ 127

Windows 8 ......................................................................................................................... 127
Using Computer Setup ........................................................................................... 127

Starting Computer Setup ......................................................................... 127
Navigating and selecting in Computer Setup ............................................. 128
Restoring factory settings in Computer Setup .............................................. 129
Updating the BIOS ................................................................................. 129

Determining the BIOS version ................................................... 129
Downloading a BIOS update .................................................... 130

vi



Using Advanced System Diagnostics ....................................................................... 131
Windows 7 ......................................................................................................................... 132

Starting Computer Setup ........................................................................................ 132
Using Computer Setup ........................................................................................... 132

Navigating and selecting in Computer Setup ............................................. 132
Restoring factory settings in Computer Setup .............................................. 133

Updating the BIOS ................................................................................................ 134
Determining the BIOS version .................................................................. 134
Downloading a BIOS update ................................................................... 134

Using Advanced System Diagnostics ....................................................................... 135
SuSE Linux (SLED) ................................................................................................................. 136

Starting Computer Setup ........................................................................................ 136
Using Computer Setup ........................................................................................... 136

Navigating and selecting in Computer Setup ............................................. 136
Restoring factory settings in Computer Setup .............................................. 137

Updating the BIOS ................................................................................................ 137
Determining the BIOS version .................................................................. 138
Downloading a BIOS update ................................................................... 138

Using Advanced System Diagnostics ....................................................................... 139

6  Specifications ...............................................................................................................  140

Computer specifications ........................................................................................................ 140
14.0-inch SGA display specifications ..................................................................................... 142
Hard drive specifications ...................................................................................................... 143

7  Backup and recovery .................................................................................................... 144

Windows 8 ......................................................................................................................... 144
Backing up your information ................................................................................... 144
Performing a system recovery ................................................................................. 145

Using the Windows recovery tools ........................................................... 145
Using f11 recovery tools ......................................................................... 146
Using Windows 8 operating system media (purchased separately) ............... 147
Using Windows Refresh for quick and easy recovery .................................. 147
Remove everything and reinstall Windows ................................................ 148
Using HP Software Setup ........................................................................ 149

Windows 7 ......................................................................................................................... 149
Creating recovery media with HP Recovery Disc Creator ............................................ 150

Creating recovery media ......................................................................... 150
Backing up your information ................................................................................... 150
Performing a system recovery ................................................................................. 151

Using the Windows recovery tools ........................................................... 151

vii



Using f11 recovery tools ......................................................................... 152
Using a Windows 7 operating system DVD (purchased separately) .............. 153

SuSE Linux (SLED) ................................................................................................................. 154
Creating backups .................................................................................................. 154
Backing up your information ................................................................................... 154
Performing a system recovery ................................................................................. 155
USB Recovery option (select models only) ................................................................. 156
Remove everything and reinstall SLED ...................................................................... 157

8  Power cord set requirements ........................................................................................ 158

Requirements for all countries ................................................................................................ 158
Requirements for specific countries and regions ....................................................................... 159

9  Recycling ...................................................................................................................... 160

Index ............................................................................................................................... 161

viii



1 Product description

Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Product Name HP ProBook 6475b Notebook PC √  

 HP ProBook 6470b Notebook PC  √

Processors ● AMD® A10-4600M 3.20-GHz/2.30-
GHz processor (4.0-MB L2 cache,
1600-MHz DDR3, quad core, 35 W)

● AMD A8-4500M 2.80-GHz/1.90-GHz
processor (4.0-MB L2 cache, 1600-
MHz DDR3, quad core, 35 W)

● AMD A6-4400M 3.20-GHz/2.70-GHz
processor (1.0-MB L2 cache, 1600-
MHz DDR3, dual core, 35 W)

● AMD A4-4300M 3.00-GHz/2.50-GHz
processor (1.0-MB L2 cache, 1600-
MHz DDR3, dual core, 35 W)

√  
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Processors (continued) ● Intel® Quad Core® i7-3540M 3.00-
GHz processor (SC turbo up to 3.70-
GHz; 1600- MHz FSB, 4.0-MB L3
cache, 35 W)

● Intel Dual Core i7-3520M 2.90-GHz
processor (SC turbo up to 3.60-GHz;
1600-MHz FSB, 4.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3380M 2.90-GHz
processor (SC turbo up to 3.60-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3360M 2.80-GHz
processor (SC turbo up to 3.50-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3340M 2.70-GHz
processor (SC turbo up to 3.40-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3320M 2.60-GHz
processor (SC turbo up to 3.30-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3210M 2.50-GHz
processor (SC turbo up to 3.10-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Core i3-3130M 2.60-GHz
processor (1600-MHz FSB, 3.0-MB L3
cache, 35 W)

● Intel Core i3-3120M 2.50-GHz
processor (1600-MHz FSB, 3.0-MB L3
cache, 35 W)

● Intel Core i3-3110M 2.40-GHz
processor (1600-MHz FSB, 3.0-MB
L3 cache, 35 W)

● Intel Core i3-2370M 2.40-GHz
processor (1333-MHz FSB, 3.0-MB
L3 cache, 35 W)

● Intel Celeron® B840 1.90-GHz
processor (1333-MHz FSB, 2.0-MB
L3 cache, 35 W)

 √

Chipset AMD A70M fusion controller hub (FCH) √  
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Chipset (continued) Mobile Intel QM77 chipset

Mobile Intel HM76 chipset

 √

Graphics AMD integrated universal memory
architecture (UMA) graphics

Support for DisplayPort 1.2

Support for dual-display ports through
the dock

√  

 ● Radeon® HD 7660G graphics on
computer models equipped with an
AMD A10-4600M 3.20-GHz/2.30-
GHz processor

● Radeon HD 7640G graphics on
computer models equipped with an
AMD A8-4500M 2.80-GHz/1.90-
GHz processor

● Radeon HD 7520G graphics on
computer models equipped with an
AMD A6-4400M 3.20-GHz/2.70-
GHz processor

● Radeon HD 7420G graphics on
computer models equipped with an
AMD A4-4300M 3.00-GHz/2.50-
GHz processor

√  

 Switchable discrete graphics: AMD
Radeon™ HD 7570M (64-bit), with 1024-
MB GDDR5 (64-MB × 32,1.5V, 5-GBPS,
quantity 4)

Internal graphics: UMA with shared
video memory

● Intel HD Graphics 4000 on computer
models equipped with an Intel Quad
Core i7, Intel Dual Core i5, and Intel
Dual Core i3 processor

● Intel HD Graphics 3000 on computer
models equipped with an Intel Dual
Core i3-2370M processor

● Intel HD Graphics on computer models
equipped with an Intel Celeron
B840 processor

 √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Graphics (continued) ● Support for dual-display ports through
docking station

● Support for DisplayPort 1.2 (only on
computer models equipped with a
graphics subsystem with
discrete memory)

● Support for up to 4 displays through
the APR (only on computer models
equipped with a graphics subsystem
with discrete memory)

 √

Panel ● 14.0-in light-emitting diode (LED), high-
definition+ (HD+), AntiGlare (AG), SVA
(1600×900) display with and without
webcam and microphone

● 14.0-in LED, HD, AG, SVA
(1366×768) display with and without
webcam and microphone

All display assemblies include two wireless
local area network (WLAN) antenna cables
and two wireless wide area network
(WWAN) antenna cables

Supports low voltage differential
signalling (LVDS)

Supports 16:9 aspect ratio

Supports privacy filter

√ √

Memory Two customer-accessible/upgradable
memory module slots

DDR3-12800 (1600-MHz) dual
channel support

Supports 16384-MB of system RAM in the
following configurations:

● 16384-MB (8192-MB×2)

● 8192-MB (8192-MB×1 or 4096×2)

● 6144-MB (4096-MB+2048-MB)

● 4096-MB (4096-MB×1 or 2048-MB×2)

● 2048-MB (2048×1)

√ √

Flash cache Intel 24-GB mSATA module (Intel Smart
Response Technology (SRT), not available on
computer models equipped with WWAN
or SSD)

 √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Hard drive Supports 6.35-cm (2.5-in) hard drives in 9.5-
mm (.37-in) and 7.0-mm (.28-in) thicknesses
(all hard drives use the same bracket)

Customer-accessible

Serial ATA

Supports the following hard drives:

● 750-GB, 7200-rpm, 9.5-mm

● 500-GB, 7200-rpm, 7.0-mm self-
encrypting drive (SED)

● 500-GB, 7200-rpm, 7.0-mm

● 320-GB, 7200-rpm, 7.0-mm

√ √

Solid-state drive Solid-state drive (SSD) mounts in the same
bracket as the hard drive

Customer-accessible

Serial ATA type II and III

Supports the following SSDs:

● 256-GB SED III

● 240-GB III

● 180-GB III

● 160-GB II

● 128-GB III

 √

 ● 128-GB SATA III √  

Upgrade drive Customer-accessible

Supports the following drive options:

● Blu-ray ROM DVD±RW SuperMulti
DL Drive

● DVD±RW Double-Layer with
SuperMulti Drive

● DVD-ROM Drive

● 500-GB, 7200-rpm, 9.5-mm

Supports no drive option

√ √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Optical drive Fixed

Serial ATA

12.7-mm tray load

Supports the following optical drives:

● Blu-ray ROM DVD±RW SuperMulti
DL Drive

● DVD±RW Double-Layer with
SuperMulti Drive

● DVD-ROM Drive

Supports zero power optical drive

√ √

Audio and video Two stereo speakers √ √

 HD audio with SRS Premium Sound PRO √ √

 Integrated 720p HD webcam (supports no
camera option)

√ √

 Integrated dual-array microphone on
computer models equipped with a webcam

Integrated mono microphone on computer
models not equipped with a webcam

√ √

Modem 56kbps v.92 MDC data/fax modem module

Supports no modem option

Modem module cable not included

√ √

Ethernet Realtek RTL8151FH-CG 10/100/1000
Ethernet network interface card (NIC)

NIC Power Down technology

S3/S4/S5 wake on LAN

Ethernet cable not included

√ √

Wireless Integrated wireless personal area network
(WPAN) option by way of Bluetooth 4.0
enhanced data rate (EDR) module

Supports no WPAN option

√ √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Wireless (continued) Integrated wireless local area network
(WLAN) options by way of wireless module

Three WLAN antennas built into
display assembly

Support for the following WLAN formats:

● Atheros WB225 1×1 802.11b/g/n
Bluetooth Combo Adapter

● Broadcom 43228 802.11abgn 2×2
Wi-Fi Adapter

● Intel Centrino Advanced-N 6205
Combo Adapter

● Intel Centrino Advanced-N 6205
WLAN module

● Intel Centrino Ultimate-N 6300
WLAN module

● Intel Centrino Wireless-N 2200
802.11b/g/n 2×2 WiFi Adapter

Supports no WLAN option

√ √

 Integrated wireless wide area network
(WWAN) options by way of
wireless module

Two world-wide/5-band WWAN antennas
built into display assembly

Secured by subscriber identity module (SIM,
user-accessible behind battery)

Support for the following WWAN formats:

● HP hs2350 HSPA+ Mobile
Broadband Module

● HP lt2523 LTE/HSPA+ Mobile
Broadband Module

● HP un2430 EV-DO/HSPA Mini Card

● HP lt2522 LTE/EV-DO Mobile
Broadband Module

● HP un2430 EV-DO/HSPA Mini Card

● HP un2430 EV-DO/HSPA Mobile
Broadband Module

Supports no WWAN option

Supports WWAN after market option

√ √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

External media
cards

Integrated 54-mm ExpressCard

Secure Digital (SD) flash media slot with
push-push technology, supporting the
following digital card formats:

● MultiMediaCard (MMC)

● MMC+

● Secure Digital (SD) Memory Card

● SDHC

● SDXC

√ √

Ports ● 1394a port

● Audio-in (mono microphone)

● Audio-out (stereo headphone)

● Battery connector

● DisplayPort 1.2 (on computer models
equipped with a graphics subsystem
with discrete memory)

● DisplayPort 1.1a (on computer models
equipped with a graphics subsystem
with UMA memory)

● Docking connector

● eSATA/USB 2.0 combo port

● HP Smart AC adapter

● RJ-45 (Ethernet)

● RJ-11 (modem)

● Secondary battery connector

● Serial port

● USB 3.0 ports (2)

● USB 2.0 port

● USB 2.0 charging port

● VGA (Dsub 15 pin) supporting:
1920×1200 external resolution @
75 Hz, hot plug and unplug and
autodetection for correct output to wide-
aspect vs. standard aspect video

√ √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Keyboard/pointing
devices

Full-size keyboard with numeric keypad
(upper-left justified), dual-point, spill-resistant,
chiclet-style, with durakeys

√ √

 Gesture support: MultiTouch gestures
enabled, two-finger scrolling, and pinch-
zoom as default

√ √

 Taps enabled by default √ √

 Support for TouchPad with image sensor √ √

 Support for Windows 8 Indirect Touch √ √

Power requirements Supports the following HP Smart AC adapters:

 ● 90-W HP Smart AC adapter (PFC,
EM, 3-wire)

√ √

 ● 90-W HP Smart AC adapter (PFC, 3-
wire)

√ √

 ● 65-W HP Smart AC adapter (non-
PFC, 3-wire)

√ √

 ● 65-W HP Smart AC adapter (RC/V,
EM, 3-wire)

√ √

 Supports the following batteries:

● 9-cell, 100-Wh, 3.0-Ah battery

● 9-cell, 73-Wh, 2.2-Ah battery

● 6-cell, 62-Wh, 2.8-Ah battery

● 6-cell, 55-Wh, 2.8-Ah battery

● 3-cell, 31-Wh, 2.8-Ah battery

√ √

Security Supports security cable lock √ √

 Supports fingerprint reader and no
fingerprint reader option

√ √

 Supports Trusted Platform Module (TPM) 1.2
(Infineon, soldered down) and
TPM Enhanced Drive Lock (not supported in
Asia and the People's Republic of China)

√ √

 Integrated Smart Card reader (active) √ √

 Full volume encryption √ √

 Preboot authentication (password,
Smart Card)

√ √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Operating system Preinstalled:

● Windows® 8 ML 64 with Microsoft
Basics (Japan only)

● Windows 8 Professional 64 with
Microsoft Basics (Japan only)

● Windows 8 Professional 64 DPK with
Windows 7 Professional 64 and 32
(Japan only)

● Windows 7 Home Premium 64 and 32
with Microsoft Basics

● Windows 7 Professional 64 and 32
with Microsoft Basics

● Windows 7 Service Pack 1

● FreeDOS

● SUSE Linux (SLED; People's Republic of
China only)

√ √

 Preinstalled with Microsoft Office:

● Windows 8 CH 64-bit with Office
2010 Transition OPK (People's
Republic of China only)

● Windows 8 EM 64-bit with Office
2010 Transition OPK (not available
in Japan)

● Windows 8 ML 64-bit with Office
2010 Business and Home (Japan only;
requires configuration with Office
Personal Japan 2010 app AV)

● Windows 8 ML 64-bit with Office
2010 Personal (Japan only; requires
configuration with Office Personal
Japan 2010 app AV)

● Windows 8 ML 64-bit with Office
2010 Professional (Japan only;
requires configuration with Office
Personal Japan 2010 app AV)

● Windows 8 ML 64-bit with Office
2010 Transition OPK (not available
in Japan)

(Continued)

√ √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Operating system
(continued)

Preinstalled with Microsoft Office:
(continued)

● Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Business and
Home (Japan only; requires
configuration with Office Personal
Japan 2010 app AV)

● Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Personal
(Japan only; requires configuration with
Office Personal Japan 2010 app AV)

● Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Professional
(Japan only; requires configuration with
Office Personal Japan 2010 app AV)

● Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Starter (not
available in Asia-Pacific countries and
regions, Japan, or the People's
Republic of China)

● Windows 8 Professional 64-bit with
Office 2010 Business and Home
(Japan only; requires configuration with
Office Personal Japan 2010 app AV)

● Windows 8 Professional 64-bit with
Office 2010 Personal (Japan only;
requires configuration with Office
Personal Japan 2010 app AV)

● Windows 8 Professional 64-bit with
Office 2010 Professional (Japan only;
requires configuration with Office
Personal Japan 2010 app AV)

● Windows 8 Professional 64-bit with
Office 2010 Transition OPK (not
available in Japan)

● Windows 7 Home Basic 32-bit with
Office Starter (emerging markets only)

(Continued)

√ √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Operating system
(continued)

Preinstalled with Microsoft Office:
(Continued)

● Windows 7 Home Premium 64- and
32-bit with Office Starter (not available
in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Personal (only in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Home & Business (only
in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Personal (only in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Professional (only
in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Starter (not available
in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Business & Home
(only in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Personal (only
in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Professional (only
in Japan)

√ √

 Restore media—DR-DVD:

● Windows 8 (available with any
Windows 8 operating system and
required with Windows 8 Professional
64-bit DPK with Windows 7 image)

● Windows 7 (available with any
Windows 7 HP, Windows 7
Professional loc, Windows 7 HB, or
Windows 8 Professional 64-bit DPK
with Windows 7 image)

√ √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Operating system
(continued)

Restore media—OS-DVD:

● Windows 8 Professional 64-bit
(required with Windows 8 Professional
64-bit DPK with Windows image)

● Windows 7 Home Basic 32-bit
(available with any Windows 7 Home
Basic location except Asia-Pacific
countries and regions and the People's
Republic of China)

● Windows 7 Home Premium 64- and
32-bit (available with any Windows 7
Premium location except Asia-Pacific
countries and regions and the People's
Republic of China)

● Windows 7 Professional 64- and 32-bit
(available with any Windows 7
Professional or Windows 8 Professional
64-bit DPK with Windows image
location except Asia-Pacific countries
and regions and the People's Republic
of China)

√ √

 Certified:

● Microsoft WHQL

● SuSE Linux Enterprise (SLED) 64-bit
Service Pack 2

√ √
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Category Description HP ProBook 6475b
Notebook PC

HP ProBook 6470b
Notebook PC

Operating system
(continued)

Web-only support:

● Windows XP Pro 32-bit

● Windows 7 Enterprise 64- and 32-bit

● Windows 7 Ultimate 64- and 32-bit

√ √

Serviceability End user replaceable parts:

● AC adapter

● Battery

● Hard drive

● Keyboard

● Memory module

● mSATA drive

● Optical drive

● Solid-state drive

● WLAN module

● WWAN module

√ √
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2 External component identification

Display

Item Component Description

(1) Internal display switch Turns off the display or initiates Suspend if the display is
closed while the power is on.

NOTE: The display switch is not visible from the outside
of the computer.

(2) WLAN antennas (2)* Send and receive wireless signals to communicate
with WLANs.

(3) Internal microphones (2, select models only) Record sound.

NOTE: Only models equipped with a webcam have 2
internal microphones. Models without a webcam have
only 1 internal microphone.

(4) Webcam light (select models only) On: The webcam is in use.

Display 15



Item Component Description

(5) Webcam (select models only) Records video and captures still photographs.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region.
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Buttons and fingerprint reader (select models only)
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) TouchPad on/off button Turns the TouchPad on and off.

(2) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to
initiate Suspend.

● When the computer is in the Suspend state, press
the button briefly to exit Suspend.

● When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and operating
system shutdown procedures are ineffective, press and
hold the power button for at least 5 seconds to turn off
the computer.

To learn more about your power settings:

● Windows 8—From the Start screen, type power,
select Settings, and then select Power Options.

● Windows 7:

1. Select Computer > Control Center.

2. In the left pane, click System, and then click
Power Management in the right pane.

(3) Wireless button Turns the wireless feature on or off but does not establish
a wireless connection.

Buttons and fingerprint reader (select models only) 17



Item Component Description

(4) Web browser button ● When the computer is on, press the button to open
the default Web browser.

● When the computer is off, in the Suspend state, or
in Hibernation, the button does not perform any
action or function.

(5) Volume mute button Mutes and restores speaker sound.

(6) Fingerprint reader (select models only) Allows a fingerprint logon instead of a password logon.

Keys
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key.

(3) Operating system logo key Displays the operating system menu.

(4) Operating system applications key Displays a shortcut menu for items beneath the cursor.
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Item Component Description

(5) Embedded numeric keypad When the keypad is turned on, it can be used like an
external numeric keypad.

Each key on the keypad performs the function indicated
by the icon in the upper-right corner of the key.

(6) num lk key Turns the embedded numeric keypad on and off when
pressed in combination with the fn key.

Lights
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) TouchPad light ● Amber: The TouchPad is off.

● Off: The TouchPad is on.

(2) Caps lock light ● On: Caps lock is on.

● Off: Caps lock is off.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Suspend state.

● Off: The computer is off or in Hibernation.

(4) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.
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Item Component Description

(5) Web browser light ● On: The computer is on.

● Off: The computer is off, in the Suspend state, or
in Hibernation.

(6) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

(7) Num lock light On: Num lock is on.

TouchPad
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Pointing stick (select models only) Moves the pointer and selects or activates items on
the screen.

(2) Left pointing stick button (select models
only)

Functions like the left button on an external mouse.

(3) TouchPad on/off button Turns the TouchPad on or off.

(4) TouchPad zone Moves the pointer and selects or activates items on
the screen.
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Item Component Description

(5) Left TouchPad button Functions like the left button on an external mouse.

(6) Right pointing stick button (select models
only)

Functions like the right button on an external mouse.

(7) Right TouchPad button Functions like the right button on an external mouse.

Front
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Display release latch Opens the computer.

(2) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Suspend state.

● Off: The computer is off or in Hibernation.

(4) AC adapter/Battery light ● Amber: The computer is connected to external
power and the battery is charged from 0 to
90 percent.

● White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

● Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level, the
battery light begins blinking rapidly.

● Off: The battery is fully charged.
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Item Component Description

(5) Hard drive light ● Blinking white: The hard drive or optical drive is
being accessed.

● Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(6) Speakers (2) Produce sound. One of the speakers is on the bottom of
the computer, and it cannot be seen from the front of the
computer.

Left side
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Power connector Connects an AC adapter.

(2) 1394 port Connects an optional IEEE 1394 or 1394a device, such
as a camcorder.

(3) USB 3.0 ports (2) Connect optional USB 3.0 devices and provide
enhanced USB power performance.

(4) HP ExpressCard slot or Smart Card reader
(depending on configuration)

Supports optional ExpressCards or Smart Cards.

(5) Media Card Reader Supports the following digital card formats:

● MultiMediaCard (MMC)

● MMC+

● Secure Digital (SD) Memory Card

● SDHC

● SDXC
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Item Component Description

(6) Upgrade bay (optical drive shown) The upgrade bay can hold a weight-saver option, a hard
drive, or an optical drive that reads an optical disc.

NOTE: On select models, the optical drive also writes
to an optical disc.

(7) Optical drive eject button (select models
only)

Releases the disc tray.

Right side
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and
Environmental Notices.

NOTE: When a device is connected to the jack,
the computer speakers are disabled.

(2) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(3) eSATA/USB 2.0 port Connects an optional high-performance eSATA
component, such as an eSATA external hard drive, or
connects an optional USB device.

(4) USB 2.0 port Connects an optional USB device.

(5) DisplayPort Connects an optional digital display device, such as a
high-performance monitor or projector.
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Item Component Description

(6) Vents (2) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(7) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

Rear
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) RJ-11 (modem) jack Connects a modem cable.

(2) External monitor port Connects an external VGA monitor or projector.

(3) RJ-45 (network) jack Connects a network cable.
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Bottom
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Vents (4) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(2) Battery release latch Releases the battery.

(3) Docking connector Connects an optional docking device.

(4) Service cover release latch Releases the service cover from the computer.

(5) Battery bay Holds the battery.

(6) Accessory battery connector Connects an optional accessory battery.
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Item Component Description

(7) Bluetooth compartment Contains a Bluetooth device.

(8) Service cover Provides access to the hard drive, and also contains the
WLAN module slot and the memory module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact support.
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Service tag
When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 34 for battery removal instructions.

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 40.

(2) Keyboard with pointing stick (includes keyboard cable and pointing stick cable):

 For use only on computer models equipped with the Windows 8 operating system:

 For use in Belgium 701975-A41

 For use in Brazil 701975-201

 For use in Bulgaria 701975-261

 For use in Canada 701975-DB1

 For use in the Czech Republic and Slovakia 701975-FL1

 For use in Denmark 701975-081

 For use in France 701975-051

 For use in Germany 701975-041

 For use in Greece 701975-151

 For use in Hungary 701975-211

 For use in Iceland 701975-DD1

 For use in India 701975-D61

 For use in Israel 701975-BB1

 For use in Italy 701975-061

 For use in Japan 701975-291

 For use in Latin America 701975-161

 For use in the Netherlands 701975-B31

 For use in Norway 701975-091

 For use in Northwest Africa 701975-FP1

 For use in Portugal 701975-131

 For use in Romania 701975-271

 For use in Russia 701975-251

 For use in Saudi Arabia 701975-171

 For use in Slovenia 701975-BA1

 For use in South Korea 701975-AD1

 For use in Spain 701975-071

 For use in Sweden and Finland 701975-B71

 For use in Switzerland 701975-BG1

 For use in Taiwan 701975-AB1
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Item Component Spare part number

 For use in Thailand 701975-281

 For use in Turkey 701975-141

 For use in the United Kingdom and Singapore 701975-031

 For use in the United States 701975-001

 For use only on computer models equipped with the Windows 7 operating system:

 For use in Belgium 684332-A41

 For use in Brazil 684332-201

 For use in Bulgaria 684332-261

 For use in Canada 684332-DB1

 For use in the Czech Republic and Slovakia 684332-A81

 For use in Denmark 684332-081

 For use in France 684332-051

 For use in Germany 684332-041

 For use in Greece 684332-DJ1

 For use in Hungary 684332-211

 For use in Iceland 684332-DD1

 For use in India 684332-D61

 For use in Israel 684332-BB1

 For use in Italy 684332-061

 For use in Japan 684332-291

 For use in Latin America 684332-161

 For use in the Netherlands 684332-B31

 For use in Norway 684332-091

 For use in Northwest Africa 684332-FP1

 For use in Portugal 684332-131

 For use in Romania 684332-271

 For use in Russia 684332-251

 For use in Saudi Arabia 684332-171

 For use in Slovenia 684332-BA1

 For use in South Korea 684332-AD1

 For use in Spain 684332-071

 For use in Sweden and Finland 684332-B71
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Item Component Spare part number

 For use in Switzerland 684332-BG1

 For use in Taiwan 684332-AB1

 For use in Thailand 684332-281

 For use in Turkey 684332-141

 For use in the United Kingdom and Singapore 684332-031

 For use in the United States 684332-001

(2) Keyboard without pointing stick (includes keyboard cable):

 For use only on computer models equipped with the Windows 8 operating system:

 For use in Belgium 701976-A41

 For use in Brazil 701976-201

 For use in Bulgaria 701976-261

 For use in Canada 701976-DB1

 For use in the Czech Republic and Slovakia 701976-FL1

 For use in Denmark 701976-081

 For use in France 701976-051

 For use in Germany 701976-041

 For use in Greece 701976-151

 For use in Hungary 701976-211

 For use in Iceland 701976-DD1

 For use in India 701976-D61

 For use in Israel 701976-BB1

 For use in Italy 701976-061

 For use in Japan 701976-291

 For use in Latin America 701976-161

 For use in the Netherlands 701976-B31

 For use in Norway 701976-091

 For use in Northwest Africa 701976-FP1

 For use in Portugal 701976-131

 For use in Romania 701976-271

 For use in Russia 701976-251

 For use in Saudi Arabia 701976-171

 For use in Slovenia 701976-BA1
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Item Component Spare part number

 For use in South Korea 701976-AD1

 For use in Spain 701976-071

 For use in Sweden and Finland 701976-B71

 For use in Switzerland 701976-BG1

 For use in Taiwan 701976-AB1

 For use in Thailand 701976-281

 For use in Turkey 701976-141

 For use in the United Kingdom and Singapore 701976-031

 For use in the United States 701976-001

 For use only on computer models equipped with the Windows 7 operating system:

 For use in Belgium 684333-A41

 For use in Brazil 684333-201

 For use in Bulgaria 684333-261

 For use in Canada 684333-DB1

 For use in the Czech Republic and Slovakia 684333-A81

 For use in Denmark 684333-081

 For use in France 684333-051

 For use in Germany 684333-041

 For use in Greece 684333-DJ1

 For use in Hungary 684333-211

 For use in Iceland 684333-DD1

 For use in India 684333-D61

 For use in Israel 684333-BB1

 For use in Italy 684333-061

 For use in Japan 684333-291

 For use in Latin America 684333-161

 For use in the Netherlands 684333-B31

 For use in Norway 684333-091

 For use in Northwest Africa 684333-FP1

 For use in Portugal 684333-131

 For use in Romania 684333-271

 For use in Russia 684333-251

Computer major components 33



Item Component Spare part number

 For use in Saudi Arabia 684333-171

 For use in Slovenia 684333-BA1

 For use in South Korea 684333-AD1

 For use in Spain 684333-071

 For use in Sweden and Finland 684333-B71

 For use in Switzerland 684333-BG1

 For use in Taiwan 684333-AB1

 For use in Thailand 684333-281

 For use in Turkey 684333-141

 For use in the United Kingdom and Singapore 684333-031

 For use in the United States 684333-001

(3) Top cover (includes TouchPad):

 Equipped with 2 pointing stick buttons, 2 TouchPad buttons, and a fingerprint reader 684336-001

 Equipped with 2 pointing stick buttons and a fingerprint reader 684338-001

(4) Fan (includes cable) 641839-001

(5) Heat sink (includes replacement thermal material):

 Heat sink for use only on HP ProBook 6475p Notebook PC computer models 658543-001

Heat sink for use only on HP ProBook 6470b Notebook PC computer models
equipped with a graphics subsystem with discrete memory

686021-001

 Heat sink for use only on HP ProBook 6470b Notebook PC computer models
equipped with a graphics subsystem with UMA memory

693371-001

(6) System board (includes replacement thermal material):

 For use only on HP ProBook 6475b Notebook PC computer models:

 For use on computer models equipped with the Windows 8 Professional operating
system and WWAN capability in all countries and regions except in the People's
Republic of China and the Ukraine

684341-601

 For use on computer models equipped with the Windows 8 Standard operating system
and WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

684341-501

 For use on computer models equipped with the Windows 7 operating system
and WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

684341-001

 For use on computer models equipped with the Windows 8 Professional operating
system but without WWAN capability in all countries and regions except in the
People's Republic of China and the Ukraine

684342-601
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 For use on computer models equipped with the Windows 8 Standard operating system
but without WWAN capability in all countries and regions except in the People's
Republic of China and the Ukraine

684342-501

 For use on computer models equipped with the Windows 7 operating system but
without WWAN capability in all countries and regions except in the People's Republic
of China and the Ukraine

684342-001

 For use on computer models equipped with the Windows 7 operating system
and WWAN capability only in the People's Republic of China and the Ukraine

690036-001

 For use on computer models equipped with the Windows 7 operating system but not
WWAN capability only in the People's Republic of China and the Ukraine

690037-001

 For use only on HP ProBook 6470b Notebook PC computer models:

 For use on computer models equipped with the Intel QM77 chipset, a graphics
subsystem with discrete memory, the Windows 8 Professional operating system,
and WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

686039-601

 For use on computer models equipped with the Intel QM77 chipset, a graphics
subsystem with discrete memory, the Windows 8 Standard operating system,
and WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

686039-501

 For use on computer models equipped with the Intel QM77 chipset, a graphics
subsystem with discrete memory, the Windows 7 operating system, and WWAN
capability in all countries and regions except in the People's Republic of China
and the Ukraine

686039-001

 For use on computer models equipped with the Intel QM77 chipset, a graphics
subsystem with UMA memory, the Windows 8 Professional operating system,
and WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

686037-601

 For use on computer models equipped with the Intel QM77 chipset, a graphics
subsystem with UMA memory, the Windows 8 Standard operating system,
and WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

686037-501

 For use on computer models equipped with the Intel QM77 chipset, a graphics
subsystem with UMA memory, the Windows 7 operating system, and WWAN
capability in all countries and regions except in the People's Republic of China
and the Ukraine

686037-001

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with discrete memory, the Windows 8 Professional operating system,
and WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

686038-601

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with discrete memory, the Windows 8 Standard operating system,
and WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

686038-501

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with discrete memory, the Windows 7 operating system, and WWAN
capability in all countries and regions except in the People's Republic of China
and the Ukraine

686038-001
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 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with UMA memory, the Windows 8 Professional operating system,
and WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

686036-601

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with UMA memory, the Windows 8 Standard operating system,
and WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

686036-501

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with UMA memory, the Windows 7 operating system, and WWAN
capability in all countries and regions except in the People's Republic of China
and the Ukraine

686036-001

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with UMA memory, and the Windows 8 Professional operating system, but
without WWAN capability in all countries and regions except in the People's Republic
of China and the Ukraine

686035-601

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with UMA memory, and the Windows 8 Standard operating system, but
without WWAN capability in all countries and regions except in the People's Republic
of China and the Ukraine

686035-501

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with UMA memory, and the Windows 7 operating system, but without
WWAN capability in all countries and regions except in the People's Republic of
China and the Ukraine

686035-001

 For use on computer models equipped with the Intel QM77 chipset, a graphics
subsystem with discrete memory, the Windows 7 operating system, and WWAN
capability only in the People's Republic of China and the Ukraine

691715-001

 For use on computer models equipped with the Intel QM77 chipset, a graphics
subsystem with UMA memory, the Windows 7 operating system, and WWAN
capability only in the People's Republic of China and the Ukraine

691713-001

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with discrete memory, the Windows 7 operating system, and WWAN
capability only in the People's Republic of China and the Ukraine

691714-001

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with UMA memory, the Windows 7 operating system, and WWAN
capability only in the People's Republic of China and the Ukraine

691712-001

 For use on computer models equipped with the Intel HM76 chipset, a graphics
subsystem with UMA memory, the Windows 7 operating system, but without WWAN
capability only in the People's Republic of China and the Ukraine

691711-001

(7) Speaker assembly (includes cable) 641840-001

(8) Processor (includes replacement thermal material):

 For use only on HP ProBook 6475b Notebook PC computer models:

 AMD A10-4600M 3.20-GHz/2.30-GHz processor with Radeon HD 7660G graphics
(4.0-MB L2 cache, 1600-MHz DDR3, quad core, 35 W)

683046-001
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 AMD A8-4500M 2.80-GHz/1.90-GHz processor with Radeon HD 7640G graphics
(4.0-MB L2 cache, 1600-MHz DDR3, quad core, 35 W)

683048-001

 AMD A6-4400M 3.20-GHz/2.70-GHz processor with Radeon HD 7520G graphics
(1.0-MB L2 cache, 1600-MHz DDR3, dual core, 35 W)

683047-001

 AMD A4-4300M 3.00-GHz/2.50-GHz processor with Radeon HD 7420G graphics
(1.0-MB L2 cache, 1600-MHz DDR3, dual core, 35 W)

685990-001

 For use only on HP ProBook 6470b Notebook PC computer models:

 Intel Quad Core i7-3540M 3.00-GHz processor (SC turbo up to 3.70-GHz; 1600-
MHz FSB, 4.0- MB L3 cache, 35 W)

710787-001

 Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz
FSB, 4.0-MB L3 cache, 35 W)

681954-001

 Intel Dual Core i5-3380M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

708762-001

 Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

681953-001

 Intel Dual Core i5-3340M 2.70-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

708761-001

 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

711903-001

 Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

680645-001

 Intel Core i3-3130M 2.60-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 713163-001

 Intel Core i3-3120M 2.50-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 700627-001

 Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001

 Intel Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 677152-001

 Intel Celeron B840 1.90-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, 35 W) 664663-001

(9) Modem module

NOTE: The modem module cable is included in the Cable Kit, spare part number
641830-001.

628824-001

(10) Function board 658142-001

(11) USB board 658141-001

(12) Base enclosure (includes rubber feet, service cover release latch assembly, and battery release latch assembly)

 For use only on computer models equipped with WWAN capability 684334-001

 For use only on computer models not equipped with WWAN capability 687224-001

 Rubber Kit (not illustrated, includes display bezel left and right rubber screw covers,
base enclosure front and rear rubber screw covers, top cover rubber bumper)

641831-001

 Latch Kit (not illustrated, includes service cover release latch assembly components
and battery release latch assembly components)

684339-001
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(13) Battery (Li ion):

 9-cell, 100-Wh, 3.00-Ah 631243-001

 9-cell, 100-Wh, 3.00-Ah 634087-001

 9-cell, 73-Wh, 2.20-Ah 634089-001

 6-cell, 62-Wh, 2.80-Ah 628668-001

 6-cell, 55-Wh, 2.80-Ah 628670-001

 6-cell, 51-Wh, 2.55-Ah 659083-001

 3-cell, 31-Wh, 2.80-Ah 628664-001

(14) Bluetooth module 4.0 EDR

NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number
641830-001.

655792-001

(15) Memory modules (PC3-12800, 1666-MHz, DDR3):

 8-GB 670034-001

 4-GB locked 707248-001

 4-GB 641369-001

 2-GB 652972-001

(16) WLAN module:

 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter 675794-001

 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter 669832-001

 Intel Centrino Advanced-N 6205 WLAN module 695915-001

 Intel Centrino Ultimate-N 6300 WLAN module 572511-001

 Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adaptor 670288-001

(17) WWAN module:

 HP hs2350 HSPA+ Mobile Broadband Module 710788-001

 HP lt2523 LTE/HSPA+ Mobile Broadband Module 710790-001

 HP lt2522 LTE/EV-DO Mobile Broadband Module 710789-001

 HP un2430 EV-DO/HSPA Mini Card 702080-001

 HP un2430 EV-DO/HSPA Mobile Broadband Module 668969-001

(18) RTC battery 651948-001

(19) Optical drive (includes optical drive bezel and optical drive bracket):

 Blu-ray ROM DVD±RW SuperMulti DL Drive 684330-001

 DVD±RW Double-Layer with SuperMulti Drive 684329-001

 DVD-ROM Drive 684328-001
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(20) Hard drive (does not include hard drive bracket or screws):

 750-GB, 7200-rpm, 9.5-mm 633252-001

 500-GB, 7200-rpm, 9.5-mm self-encrypting drive 683801-001

 500-GB, 7200-rpm, 9.5-mm 634925-001

 320-GB, 7200-rpm, 9.5-mm 634862-001

 Hard Drive Hardware Kit (not illustrated, includes hard drive bracket and screws) 642774-001

(21) Service cover

 Includes label indicating “Made in China” 684326-001

 Includes label indicating country of origin 699324-001
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(1) Display bezel:

 For use only on HP ProBook 6475b Notebook PC computer models 683781-001

 For use only on HP ProBook 6470b Notebook PC computer models 685999-001

 Display Hinge Cover Kit, includes: 642783-001

(2) Display hinge covers

(3) Display Hinge Kit (includes left and right display hinges and left and right
hinge brackets)

641836-001

(4) Display panel:

 For use on all computer models:

 14.0-in, LED, SVA, HD+, AntiGlare display panel 684348-001

 14.0-in, LED, SVA, HD, AntiGlare display panel 684347-001

 For use only on HP ProBook 6470b Notebook PC computer models:

 14.0-in, LED, FLT, HD+, AntiGlare display panel 686047-001

 14.0-in, LED, FLT, HD, AntiGlare display panel 686046-001

(5) Webcam/microphone module 684346-001

 Microphone module 642797-001

 Display Cable Kit, includes:

(6) Display panel cable:

 For use only on computer models equipped with an HD+ display assembly 693064-001

 For use only on computer models equipped with an HD display assembly 693063-001

(7) WWAN Antenna Kit (includes left and right WWAN antenna cables
and transceivers)

642801-001

(8) WLAN Antenna Kit (includes left and right WLAN antenna cables and transceivers) 642799-001

(9) Display enclosure 642778-001

 Display Panel Support Kit (not illustrated, includes WLAN antenna cables
and transceivers, WWAN antenna cables and transceivers, and display enclosure)

657836-001

 Display Rubber Kit (not illustrated, includes display bezel rubber screw covers
and display bezel rubber bumpers)

642785-001

 Display Miscellaneous Kit 697439-001
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Cable Kit

Item Component Spare part number

 Cable Kit, includes: 641830-001

(1) Bluetooth module cable

(2) TouchPad board cable

(3) RJ-11 jack cable
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Plastics Kit

Item Description Spare part number

 Plastics Kit, includes: 684351-001

(1) RJ-11 jack plug

(2) ExpressCard slot space saver

(3) Optical drive bay space saver
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Mass storage devices

Item Description Spare part number

(1) Hard drive (does not include hard drive bracket or screws):

 750-GB, 7200-rpm, 9.5-mm 633252-001

 500-GB, 7200-rpm, 9.5-mm SED 683801-001

 500-GB, 7200-rpm, 9.5-mm 634925-001

 320-GB, 7200-rpm, 9.5-mm 634862-001

 Hard Drive Hardware Kit, includes: 642774-001

(2) Hard drive bracket
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 Hard drive bracket screws (not illustrated)

(3) Optical drive (includes optical drive bezel and optical drive bracket):

 Blu-ray ROM DVD±RW SuperMulti DL Drive 684330-001

 DVD±RW Double-Layer with SuperMulti Drive 684329-001

 DVD-ROM Drive 684328-001

(4) Upgrade bay (includes bezel and bracket) 643926-001

(5) Solid-state drive (does not include solid-state drive bracket or screws):

 128-GB SATA III solid-state drive for use only on HP ProBook 6475b Notebook PC
computer models

692425-001

 For use only on HP ProBook 6470b Notebook PC computer models:

 256-GB SATA III self-encrypting solid-state drive 691466-001

 256-GB SATA III solid-state drive 709167-001

 240-GB SATA III solid-state drive 702242-001

 180-GB SATA III solid-state drive 692097-001

 160-GB SATA II solid-state drive 693863-001

 128-GB SATA III solid-state drive 700626-001

 24-GB flash cache module (not illustrated, for use only on HP ProBook 6470b
Notebook PC computer models)

689954-001
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Miscellaneous parts

Component Spare part number

AC adapter:

90-W HP Smart AC adapter (PFC, EM, 3-wire) 693713-001

90-W HP Smart AC adapter (PFC, 3-wire) 693712-001

65-W HP Smart AC adapter (non-PFC, 3-wire) 693711-001

65-W HP Smart AC adapter (RC/V, EM, 3-wire) 693710-001

Carrying case:

HP basic carrying case 455084-001

HP essential nylon case 612757-001

HP professional top-load slim case 592923-001

Lock:

HP notebook computer combination lock 591699-001

HP notebook computer keyed cable lock 626729-001

Optical mouse:

HP USB optical travel mouse 434594-001

HP USB/PS2 2-button optical mouse 390632-001

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Denmark 490371-081

For use in Europe 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1
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For use in Thailand 490371-201

For use in the United Kingdom and Singapore 490371-031

Screw Kit 686032-001

Sequential part number listing

Spare part number Description

390632-001 HP USB/PS2 2-button optical mouse

434594-001 HP USB optical travel mouse

455084-001 HP basic carrying case

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use in India (3-pin, black, 1.83-m)

572511-001 Intel Centrino Ultimate-N 6300 WLAN module

591699-001 HP notebook computer combination lock

592923-001 HP professional top load slim case

612757-001 HP essential nylon case

626729-001 HP notebook computer keyed cable lock

628664-001 3-cell, 31-Wh, 2.80-Ah, Li-ion battery
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628668-001 6-cell, 62-Wh, 2.80-Ah, Li-ion battery

628670-001 6-cell, 55-Wh, 2.80-Ah, Li-ion battery

628824-001 Modem module (does not include the modem module cable)

NOTE: The modem module cable is included in the Cable Kit, spare part number 641830-001.

631243-001 9-cell, 100-Wh, 3.0-Ah, Li-ion battery

633252-001 750-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

634087-001 9-cell, 100-Wh, 3.00-Ah, Li-ion battery

634089-001 6-cell, 73-Wh, 2.20-Ah, Li-ion battery

634862-001 320-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

634925-001 500-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

641369-001 4-GB memory module (PC3, 12800, 1600-MHz)

641830-001 Cable Kit (includes Bluetooth module cable, RJ-11 jack cable, and TouchPad cable)

641831-001 Rubber Kit (includes display bezel left and right rubber screw covers, base enclosure front and rear
rubber screw covers, top cover rubber bumper)

641836-001 Display Hinge Kit (includes left and right display hinges and left and right hinge brackets)

641839-001 Fan (includes cable)

641840-001 Speaker assembly (includes cable)

642774-001 Hard Drive Hardware Kit (includes hard drive bracket and screws)

642778-001 Display enclosure

642783-001 Display Hinge Cover Kit (includes left and right display hinge covers)

642785-001 Display Rubber Kit (includes display bezel rubber screw covers and display bezel rubber bumpers)

642797-001 Microphone module

642799-001 WLAN Antenna Kit (includes left and right WLAN antenna cables and transceivers)

642801-001 WWAN Antenna Kit (includes left and right WWAN antenna cables and transceivers)

651948-001 RTC battery (includes cable and double-sided tape)

652972-001 2-GB memory module (PC3, 12800, 1600-MHz)

655792-001 Bluetooth module 4.0 EDR (does not include the Bluetooth module cable)

NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number 641830-001.
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657836-001 Display Panel Support Kit (includes display enclosure, WLAN antenna cables and transceivers,
and WWAN antenna cables and transceivers)

658543-001 Heat sink for use only on HP ProBook 6475p Notebook PC computer models (includes replacement
thermal material)

659083-001 6-cell, 51-Wh, 2.55-Ah, Li-ion battery

664663-001 Intel Celeron B840 1.90-GHz processor for use only on HP ProBook 6470b Notebook PC computer
models (1333-MHz, 2.0-MB L3 cache, 35 W; includes replacement thermal material)

668969-001 HP hs2350 HSPA+ Mobile Broadband Module

669832-001 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter

670034-001 8-GB memory module (PC3, 12800, 1600-MHz)

670288-001 Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adaptor

675794-001 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter

677152-001 Intel Core i3-2370M 2.40-GHz processor for use only on HP ProBook 6470b Notebook PC
computer models (1333-MHz FSB, 3.0-MB L3 cache, 35 W; includes replacement thermal material)

680645-001 Intel Dual Core i5-3210M 2.50-GHz processor for use only on HP ProBook 6470b Notebook PC
computer models (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)

681953-001 Intel Dual Core i5-3360M 2.80-GHz processor for use only on HP ProBook 6470b Notebook PC
computer models (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)

681954-001 Intel Dual Core i7-3520M 2.90-GHz processor for use only on HP ProBook 6470b Notebook PC
computer models (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0-MB L3 cache, 35 W; includes
replacement thermal material)

682417-001 Intel Core i3-3110M 2.40-GHz processor for use only on HP ProBook 6470b Notebook PC
computer models (1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes replacement thermal material)

683046-001 AMD A10-4600M 3.20-GHz/2.30-GHz processor with Radeon HD 7660G graphics (4.0-MB L2
cache, 1600-MHz DDR3, quad core, 35 W; includes replacement thermal material)

683047-001 AMD A6-4400M 3.20-GHz/2.70-GHz processor with Radeon HD 7520G graphics (1.0-MB L2
cache, 1600-MHz DDR3, dual core, 35 W; includes replacement thermal material)

683048-001 AMD A8-4500M 2.80-GHz/1.90-GHz processor with Radeon HD 7640G graphics (4.0-MB L2
cache, 1600-MHz DDR3, quad core, 35 W; includes replacement thermal material)

683781-001 Display bezel for use only on HP ProBook 6470p Notebook PC computer models

683801-001 500-GB, 7200-rpm, 9.5-mm SED hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

684326-001 Service cover (includes label indicating “Made in China”)

684328-001 DVD-ROM Drive

684329-001 DVD±RW Double-Layer with SuperMulti Drive

684330-001 Blu-ray ROM DVD±RW SuperMulti DL Drive
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684332-001 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in the United States (includes keyboard cable and pointing stick cable)

684332-031 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in the United Kingdom and Singapore (includes keyboard cable and pointing
stick cable)

684332-041 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Germany (includes keyboard cable and pointing stick cable)

684332-051 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in France (includes keyboard cable and pointing stick cable)

684332-061 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Italy (includes keyboard cable and pointing stick cable)

684332-071 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Spain (includes keyboard cable and pointing stick cable)

684332-081 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Denmark (includes keyboard cable and pointing stick cable)

684332-091 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Norway (includes keyboard cable and pointing stick cable)

684332-131 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Portugal (includes keyboard cable and pointing stick cable)

684332-141 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Turkey (includes keyboard cable and pointing stick cable)

684332-161 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Latin America (includes keyboard cable and pointing stick cable)

684332-171 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Saudi Arabia (includes keyboard cable and pointing stick cable)

684332-201 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Brazil (includes keyboard cable and pointing stick cable)

684332-211 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Hungary (includes keyboard cable and pointing stick cable)

684332-251 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Russia (includes keyboard cable and pointing stick cable)

684332-261 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Bulgaria (includes keyboard cable and pointing stick cable)

684332-271 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Romania (includes keyboard cable and pointing stick cable)

684332-281 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Thailand (includes keyboard cable and pointing stick cable)

684332-291 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Japan (includes keyboard cable and pointing stick cable)

684332-A41 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Belgium (includes keyboard cable and pointing stick cable)
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684332-AB1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Taiwan (includes keyboard cable and pointing stick cable)

684332-AD1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in South Korea (includes keyboard cable and pointing stick cable)

684332-B31 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in the Netherlands (includes keyboard cable and pointing stick cable)

684332-B71 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Sweden and Finland (includes keyboard cable and pointing stick cable)

684332-BA1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Slovenia (includes keyboard cable and pointing stick cable)

684332-BB1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Israel (includes keyboard cable and pointing stick cable)

684332-BG1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Switzerland (includes keyboard cable and pointing stick cable)

684332-D61 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in India (includes keyboard cable and pointing stick cable)

684332-DB1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Canada (includes keyboard cable and pointing stick cable)

684332-DD1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Iceland (includes keyboard cable and pointing stick cable)

684332-DJ1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Greece (includes keyboard cable and pointing stick cable)

684332-FL1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in the Czech Republic and Slovakia (includes keyboard cable and pointing
stick cable)

684332-FP1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Northwest Africa (includes keyboard cable and pointing stick cable)

684333-001 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in the United States (includes keyboard cable)

684333-031 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in the United Kingdom and Singapore (includes keyboard cable)

684333-041 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Germany (includes keyboard cable)

684333-051 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in France (includes keyboard cable)

684333-061 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Italy (includes keyboard cable)

684333-071 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Spain (includes keyboard cable)

684333-081 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Denmark (includes keyboard cable)
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684333-091 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Norway (includes keyboard cable)

684333-131 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Portugal (includes keyboard cable)

684333-141 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Turkey (includes keyboard cable)

684333-161 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Latin America (includes keyboard cable)

684333-171 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Saudi Arabia (includes keyboard cable)

684333-201 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Brazil (includes keyboard cable)

684333-211 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Hungary (includes keyboard cable)

684333-251 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Russia (includes keyboard cable)

684333-261 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Bulgaria (includes keyboard cable)

684333-271 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Romania (includes keyboard cable)

684333-281 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Thailand (includes keyboard cable)

684333-291 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Japan (includes keyboard cable)

684333-A41 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Belgium (includes keyboard cable)

684333-AB1 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Taiwan (includes keyboard cable)

684333-AD1 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in South Korea (includes keyboard cable)

684333-B31 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in the Netherlands (includes keyboard cable)

684333-B71 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Sweden and Finland (includes keyboard cable)

684333-BA1 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Slovenia (includes keyboard cable)

684333-BB1 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Israel (includes keyboard cable)

684333-BG1 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Switzerland (includes keyboard cable)
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684333-D61 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in India (includes keyboard cable)

684333-DB1 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Canada (includes keyboard cable)

684333-DD1 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Iceland (includes keyboard cable)

684333-DJ1 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Greece (includes keyboard cable)

684333-FL1 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in the Czech Republic and Slovakia (includes keyboard cable)

684333-FP1 Keyboard without pointing stick for use only on computer models equipped with the Windows 7
operating system in Northwest Africa (includes keyboard cable)

684334-001 Base enclosure for use only on computer models equipped with WWAN capability (includes rubber
feet, service cover release latch assembly, and battery release latch assembly)

684336-001 Top cover equipped with pointing stick buttons and a fingerprint reader for use only on
(includes TouchPad)

684338-001 Top cover not equipped with pointing stick buttons and a fingerprint reader for use only on
(includes TouchPad)

684339-001 Latch Kit (includes service cover release latch assembly components and battery release latch
assembly components)

684341-001 System board for use only on HP ProBook 6475p Notebook PC computer models equipped with
WWAN capability and the Windows 7 operating system in all countries and regions except the
People's Republic of China and the Ukraine (includes replacement thermal material)

684341-501 System board for use only on HP ProBook 6475p Notebook PC computer models equipped with
WWAN capability and the Windows 8 Standard operating system in all countries and regions
except the People's Republic of China and the Ukraine (includes replacement thermal material)

684341-601 System board for use only on HP ProBook 6475p Notebook PC computer models equipped with
WWAN capability and the Windows 8 Professional operating system in all countries and regions
except the People's Republic of China and the Ukraine (includes replacement thermal material)

684342-001 System board for use only on HP ProBook 6475p Notebook PC computer models equipped the
Windows 7 operating system but not with WWAN capability in all countries and regions except
the People's Republic of China and the Ukraine (includes replacement thermal material)

684342-501 System board for use only on HP ProBook 6475p Notebook PC computer models equipped the
Windows 8 Standard operating system but not with WWAN capability in all countries and regions
except the People's Republic of China and the Ukraine (includes replacement thermal material)

684342-601 System board for use only on HP ProBook 6475p Notebook PC computer models equipped the
Windows 8 Professional operating system but not with WWAN capability in all countries
and regions except the People's Republic of China and the Ukraine (includes replacement
thermal material)

684346-001 Webcam/microphone module

684347-001 14.0-in, LED, SVA, HD, AntiGlare display panel for use on all computer models

684348-001 14.0-in, LED, SVA, HD+, AntiGlare display panel for use on all computer models
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684351-001 Plastics Kit (includes ExpressCard slot space saver, optical drive bay space saver, RJ-11 jack plug,
and wireless antenna clips)

684353-001 Smart Card reader

685990-001 AMD A4-4300M 3.00-GHz/2.50-GHz processor with Radeon HD 7420G graphics (1.0-MB L2
cache, 1600-MHz DDR3, dual core, 35 W; includes replacement thermal material)

685999-001 Display bezel for use only on HP ProBook 6470b Notebook PC computer models

686021-001 Heat sink for use only on HP ProBook 6470b Notebook PC computer models equipped with a
graphics subsystem with discrete memory (includes replacement thermal material)

686032-001 Screw Kit

686035-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with UMA memory, the Windows 7 operating system, but
not WWAN capability in all countries and regions except the People's Republic of China
and the Ukraine (includes replacement thermal material)

686035-501 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with UMA memory, the Windows 8 Standard operating
system, but not WWAN capability in all countries and regions except the People's Republic of
China and the Ukraine (includes replacement thermal material)

686035-601 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with UMA memory, the Windows 8 Professional
operating system, but not WWAN capability in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

686036-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with UMA memory, the Windows 7 operating system,
and with WWAN capability in all countries and regions except the People's Republic of China
and the Ukraine (includes replacement thermal material)

686036-501 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with UMA memory, the Windows 8 Standard operating
system, and with WWAN capability in all countries and regions except the People's Republic of
China and the Ukraine (includes replacement thermal material)

686036-601 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with UMA memory, the Windows 8 Professional
operating system, and with WWAN capability in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

686037-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel QM77 chipset, a graphics subsystem with UMA memory, the Windows 7 operating system,
and with WWAN capability in all countries and regions except the People's Republic of China
and the Ukraine (includes replacement thermal material)

686037-501 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel QM77 chipset, a graphics subsystem with UMA memory, the Windows 8 Standard operating
system, and with WWAN capability in all countries and regions except the People's Republic of
China and the Ukraine (includes replacement thermal material

686037-601 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel QM77 chipset, a graphics subsystem with UMA memory, the Windows 8 Professional
operating system, and with WWAN capability in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material
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686038-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with discrete memory, the Windows 7 operating system,
and with WWAN capability in all countries and regions except the People's Republic of China
and the Ukraine (includes replacement thermal material)

686038-501 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with discrete memory, the Windows 8 Standard
operating system, and with WWAN capability in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

686038-601 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with discrete memory, the Windows 8 Professional
operating system, and with WWAN capability in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

686039-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel QM77 chipset, a graphics subsystem with discrete memory, the Windows 7 operating system,
and with WWAN capability in all countries and regions except the People's Republic of China
and the Ukraine (includes replacement thermal material)

686039-501 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel QM77 chipset, a graphics subsystem with discrete memory, the Windows 8 Standard
operating system, and with WWAN capability in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

686039-601 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel QM77 chipset, a graphics subsystem with discrete memory, the Windows 8 Professional
operating system, and with WWAN capability in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

686046-001 14.0-in, LED, FLT, HD, AntiGlare display panel for use only on HP ProBook 6470b Notebook PC
computer models

686047-001 14.0-in, LED, FLT, HD+, AntiGlare display panel for use only on HP ProBook 6470b Notebook PC
computer models

687224-001 Base enclosure for use only on computer models not equipped with WWAN capability (includes
rubber feet, service cover release latch assembly, and battery release latch assembly)

689954-001 24-GB flash cache module for use only on HP ProBook 6470b Notebook PC computer models

690036-001 System board for use only on HP ProBook 6475b Notebook PC computer models equipped with the
Windows 7 operating system and WWAN capability in the People's Republic of China
and the Ukraine (includes replacement thermal material)

690037-001 System board for use only on HP ProBook 6475b Notebook PC computer models equipped with the
Windows 7 operating system but not WWAN capability in the People's Republic of China
and the Ukraine (includes replacement thermal material)

691466-001 256-GB SATA III self-encrypting solid-state drive for use only on HP ProBook 6470b Notebook PC
computer models

691711-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with UMA memory, the Windows 7 operating system, but
without WWAN capability only in the People's Republic of China and the Ukraine (includes
replacement thermal material)
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691712-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with UMA memory, the Windows 7 operating system,
and with WWAN capability only in the People's Republic of China and the Ukraine (includes
replacement thermal material)

691713-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel QM77 chipset, a graphics subsystem with UMA memory, the Windows 7 operating system,
and with WWAN capability only in the People's Republic of China and the Ukraine (includes
replacement thermal material)

691714-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel HM76 chipset, a graphics subsystem with discrete memory, the Windows 7 operating system,
and with WWAN capability only in the People's Republic of China and the Ukraine (includes
replacement thermal material)

691715-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with the
Intel QM77 chipset, a graphics subsystem with discrete memory, the Windows 7 operating system,
and with WWAN capability only in the People's Republic of China and the Ukraine (includes
replacement thermal material)

692097-001 180-GB SATA III solid-state drive for use only on HP ProBook 6470b Notebook PC
computer models

692425-001 128-GB SATA III solid-state drive for use only on HP ProBook 6475b Notebook PC
computer models

693063-001 Display Cable Kit for use only on computer models equipped with an HD+ display assembly

693064-001 Display Cable Kit for use only on computer models equipped with an HD display assembly

693371-001 Heat sink for use only on HP ProBook 6470b Notebook PC computer models equipped with a
graphics subsystem with UMA memory (includes replacement thermal material)

693710-001 65-W HP Smart AC adapter (RC/V, EM, 3-wire)

693711-001 65-W HP Smart AC adapter (non-PFC, 3-wire)

693712-001 90-W HP Smart AC adapter (PFC, 3-wire)

693713-001 90-W HP Smart AC adapter (PFC, EM, 3-wire)

693863-001 160-GB SATA II solid-state drive for use only on HP ProBook 6470b Notebook PC computer models

695915-001 Intel Centrino Advanced-N 6205 Combo Adapter

697439-001 Display Miscellaneous Kit

699324-001 Service cover (includes label indicating country of origin)

700626-001 128-GB SATA III solid-state drive

700627-001 Intel Core i3-3120M 2.50-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)

701975-001 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in the United States (includes keyboard cable and pointing stick cable)

701975-031 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in the United Kingdom and Singapore (includes keyboard cable and pointing
stick cable)
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Spare part number Description

701975-041 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Germany (includes keyboard cable and pointing stick cable)

701975-051 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in France (includes keyboard cable and pointing stick cable)

701975-061 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Italy (includes keyboard cable and pointing stick cable)

701975-071 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Spain (includes keyboard cable and pointing stick cable)

701975-081 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Norway (includes keyboard cable and pointing stick cable)

701975-091 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Norway (includes keyboard cable and pointing stick cable)

701975-131 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Portugal (includes keyboard cable and pointing stick cable)

701975-141 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Turkey (includes keyboard cable and pointing stick cable)

701975-151 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Greece (includes keyboard cable and pointing stick cable)

701975-161 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Latin America (includes keyboard cable and pointing stick cable)

701975-171 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Saudi Arabia (includes keyboard cable and pointing stick cable)

701975-201 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Brazil (includes keyboard cable and pointing stick cable)

701975-211 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Hungary (includes keyboard cable and pointing stick cable)

701975-251 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Russia (includes keyboard cable and pointing stick cable)

701975-261 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Bulgaria (includes keyboard cable and pointing stick cable)

701975-271 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Romania (includes keyboard cable and pointing stick cable)

701975-281 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Thailand (includes keyboard cable and pointing stick cable)

701975-291 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Japan (includes keyboard cable and pointing stick cable)

701975-A41 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Belgium (includes keyboard cable and pointing stick cable)

701975-AB1 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Taiwan (includes keyboard cable and pointing stick cable)
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Spare part number Description

701975-AD1 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in South Korea (includes keyboard cable and pointing stick cable)

701975-B31 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in the Netherlands (includes keyboard cable and pointing stick cable)

701975-B71 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Sweden and Finland (includes keyboard cable and pointing stick cable)

701975-BA1 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Slovenia (includes keyboard cable and pointing stick cable)

701975-BB1 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Israel (includes keyboard cable and pointing stick cable)

701975-BG1 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Switzerland (includes keyboard cable and pointing stick cable)

701975-D61 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in India (includes keyboard cable and pointing stick cable)

701975-DB1 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Canada (includes keyboard cable and pointing stick cable)

701975-DD1 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Iceland (includes keyboard cable and pointing stick cable)

701975-FL1 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in the Czech Republic and Slovakia (includes keyboard cable and pointing
stick cable)

701975-FP1 Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Northwest Africa (includes keyboard cable and pointing stick cable)

701976-001 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in the United States (includes keyboard cable and pointing stick cable)

701976-031 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in the United Kingdom and Singapore (includes keyboard cable)

701976-041 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Germany (includes keyboard cable)

701976-051 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in France (includes keyboard cable)

701976-061 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Italy (includes keyboard cable)

701976-071 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Spain (includes keyboard cable)

701976-081 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Norway (includes keyboard cable)

701976-091 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Norway (includes keyboard cable)

701976-131 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Portugal (includes keyboard cable)
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Spare part number Description

701976-141 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Turkey (includes keyboard cable)

701976-151 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Greece (includes keyboard cable)

701976-161 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Latin America (includes keyboard cable)

701976-171 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Saudi Arabia (includes keyboard cable)

701976-201 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Brazil (includes keyboard cable)

701976-211 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Hungary (includes keyboard cable)

701976-251 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Russia (includes keyboard cable)

701976-261 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Bulgaria (includes keyboard cable)

701976-271 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Romania (includes keyboard cable)

701976-281 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Thailand (includes keyboard cable)

701976-291 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Japan (includes keyboard cable)

701976-A41 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Belgium (includes keyboard cable)

701976-AB1 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Taiwan (includes keyboard cable)

701976-AD1 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in South Korea (includes keyboard cable)

701976-B31 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in the Netherlands (includes keyboard cable)

701976-B71 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Sweden and Finland (includes keyboard cable)

701976-BA1 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Slovenia (includes keyboard cable)

701976-BB1 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Israel (includes keyboard cable)

701976-BG1 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Switzerland (includes keyboard cable)

701976-D61 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in India (includes keyboard cable)
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Spare part number Description

701976-DB1 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Canada (includes keyboard cable)

701976-DD1 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Iceland (includes keyboard cable)

701976-FL1 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in the Czech Republic and Slovakia (includes keyboard cable)

701976-FP1 Keyboard without pointing stick for use only on computer models equipped with the Windows 8
operating system in Northwest Africa (includes keyboard cable)

702080-001 HP un2430 EV-DO/HSPA Mini Card

702242-001 240-GB SATA III solid-state drive

707248-001 4-GB locked memory module (PC3, 12800, 1600-MHz)

708761-001 Intel Dual Core i5-3340M 2.70-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

708762-001 Intel Dual Core i5-3380M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

709167-001 256-GB SATA III Samsung solid-state drive

710787-001 Intel Quad Core i7-3540M 3.00-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 4.0-
MB L3 cache, 35 W; includes replacement thermal material)

710788-001 HP hs2350 HSPA+ Mobile Broadband Module

710789-001 HP lt2522 LTE/EV-DO Mobile Broadband Module

710790-001 HP lt2523 LTE/HSPA+ Mobile Broadband Module

711903-001 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

713163-001 Intel Core i3-3130M 2.60-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screw driver

● Magnetic screw driver

● Phillips P0 and P1 screw drivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive
and be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screw drivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 84 screws that must be removed, replaced, and/or loosened when servicing
the computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 68 for battery removal instructions.

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components
and parts are needed.
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Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part
number 641831-001. There are four rectangular rubber feet (1) and three square rubber feet (2) that
attach to the base enclosure and service cover in the locations illustrated below.
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Battery

Description Spare part number

9-cell, 100-Wh, 3.00-Ah 631243-001

9-cell, 100-Wh, 3.00-Ah 634087-001

9-cell, 73-Wh, 2.20-Ah 634089-001

6-cell, 62-Wh, 2.80-Ah 628668-001

6-cell, 55-Wh, 2.80-Ah 628670-001

6-cell, 51-Wh, 2.55-Ah 659083-001

3-cell, 31-Wh, 2.80-Ah 628664-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM

NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling
the computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Service cover

Description Spare part number

Includes label indicating “Made in China” 684326-001

Includes label indicating country of origin 699324-001

Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

Remove the service cover:

1. Slide the release latch (1) and remove the locking screw (if installed) (2).

2. Slide the release latch (3) to disengage the door from the computer.

3. Slide the door toward the front of the computer (4), and then lift the door off the computer (5).

Reverse the removal procedures to install the service cover.
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Optical drive

NOTE: The optical drive spare part kit includes an optical drive bezel and optical drive bracket.

Description Spare part number

Blu-ray ROM DVD±RW SuperMulti DL Drive 684330-001

DVD±RW Double-Layer with SuperMulti Drive 684329-001

DVD-ROM Drive 684328-001

Before removing the optical drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

5. Remove the service cover (see Service cover on page 70).

Remove the optical drive:

1. Position the computer upside-down with the right side toward you.

2. Loosen the captive Phillips screw (1) that secures the optical drive to the computer.

3. Use a flat-blade screw driver or similar tool to press on the optical drive bracket tab (2) to release
the optical drive.
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4. Remove the optical drive (3) from the computer.

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear panel
toward you.

6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the
optical drive.

7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Upgrade bay

Description Spare part number

Upgrade bay (includes bezel and bracket) 643926-001

Before removing the upgrade bay, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

5. Remove the service cover (see Service cover on page 70).

Remove the upgrade bay:

1. Position the computer upside-down with the right side toward you.

2. Remove the four Phillips PM2.0×4.0 screws that secure the upgrade bay assembly to
the computer.

3. Loosen the captive Phillips screw that secures the upgrade bay drive in the upgrade bay (1).

4. Use a flat-blade screw driver or similar tool to press on the upgrade bay bracket tab (2) to release
the upgrade bay.
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5. Remove the upgrade bay (3) from the computer.

Reverse this procedure to install the upgrade bay.

Hard drive

NOTE: The hard drive spare part kit does not include the hard drive bracket or screws.

Description Spare part number

750-GB, 7200-rpm, 9.5-mm 633252-001

500-GB, 7200-rpm, 9.5-mm SED 683801-001

500-GB, 7200-rpm, 9.5-mm 634925-001

320-GB, 7200-rpm, 9.5-mm 634862-001

Hard Drive Hardware Kit (includes hard drive bracket and screws) 642774-001

Before removing the hard drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

5. Remove the service cover (see Service cover on page 70).

74 Chapter 4   Removal and replacement procedures



Remove the hard drive:

1. Loosen the three Phillips screws (1) that secure the hard drive to the computer.

2. Use the hard drive tab (2) to slide the hard drive to the right to disconnect it from the
system board.

3. Remove the hard drive (3) from the hard drive bay.

4. If it is necessary to disassemble the hard drive, perform the following steps:

a. Remove the four Phillips PM3.0×3.0 screws (1) that secure the hard drive bracket to the
hard drive.

b. Remove the hard drive bracket (2) from the hard drive. The hard drive bracket and screws
are available in the Hard Drive Hardware Kit, spare part number 642774-001.
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Reverse this procedure to reassemble and install the hard drive.

RTC battery

Description Spare part number

RTC battery (includes cable and double-sided tape) 651948-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Optical drive (see Optical drive on page 71)

c. Hard drive (see Hard drive on page 74)

d. Modem module (see Modem module on page 85)

e. Keyboard (see Keyboard on page 88)

f. Base enclosure (see Base enclosure on page 93)

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.
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2. Detach the RTC battery (2) from the base enclosure. (The RTC battery is attached to the
base enclosure with double-sided tape.)

3. Remove the RTC battery.

Reverse this procedure to install the RTC battery.

Memory module

NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of
the computer.

Description Spare part number

8-GB memory module (PC3, 12800, 1600-MHz) 670034-001

4-GB locked memory module (PC3, 12800, 1600-MHz) 707248-001

4-GB memory module (PC3, 12800, 1600-MHz) 641369-001

2-GB memory module (PC3, 12800, 1600-MHz) 652972-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.

2. Click Support & Drivers > click Drivers & Software.
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3. In the Enter a product name/number box, type the computer model information, and then
click Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7. Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

5. Remove the service cover (see Service cover on page 70).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

NOTE: The computer uses two memory slots. The top slot houses the expansion memory module
and is shown in the first image below. The bottom slot houses the primary memory module and is
shown in the second image below.

Reverse this procedure to install a memory module.

Component replacement procedures 79



WWAN module

NOTE: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

HP hs2350 HSPA+ Mobile Broadband Module 710788-001

HP lt2523 LTE/HSPA+ Mobile Broadband Module 710790-001

HP lt2522 LTE/EV-DO Mobile Broadband Module 710789-001

HP un2430 EV-DO/HSPA Mini Card 702080-001

HP un2430 EV-DO/HSPA Mobile Broadband Module 668969-001

Before removing the WWAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

5. Remove the service cover (see Service cover on page 70).

Remove the WWAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the
base enclosure. (The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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WLAN module

Description Spare part number

Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter 675794-001

Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter 669832-001

Intel Centrino Advanced-N 6205 WLAN module 695915-001

Intel Centrino Ultimate-N 6300 WLAN module 572511-001

Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adapter 670288-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

5. Remove the service cover (see Service cover on page 70).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow
WLAN antenna cable connects to the middle terminal on the WLAN module.

2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the
base enclosure. (The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 641830-001.

Description Spare part number

Bluetooth module 4.0 EDR 655792-001

Before removing the Bluetooth module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

5. Remove the service cover (see Service cover on page 70).

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Release the Bluetooth module (2) from the clip built into the base enclosure.

3. Remove the Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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Modem module

NOTE: The modem module spare part kit does not include an RJ-11 jack cable. The RJ-11 jack cable
is included in the Cable Kit, spare part number 641830-001.

Description Spare part number

Modem module 628824-001

Before removing the modem module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

5. Remove the service cover (see Service cover on page 70).

Remove the modem module:

1. Remove the two Phillips PM2.0×3.0 screws (1) that secure the modem module to the
system board.

2. Disconnect the modem module (2) from the system board by lifting it straight up.
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3. Disconnect the modem module cable (3) from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.
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Fan

Description Spare part number

Fan (includes cable) 641839-001

Before removing the fan, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

5. Remove the service cover (see Service cover on page 70).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Loosen the three captive Phillips screws (2) that secure the fan to the top cover.

3. Remove the fan (3).

Reverse this procedure to install the fan.
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Keyboard

For use in country/region Spare part
number

For use in country/region Spare part
number

Keyboard with pointing stick (includes keyboard cable and pointing stick cable):

For use only on computer models equipped with the
Windows 8 operating system:

For use in the Netherlands 701975-B31

For use in Belgium 701975-A41 For use in Norway 701975-091

For use in Brazil 701975-201 For use in Northwest Africa 701975-FP1

For use in Bulgaria 701975-261 For use in Portugal 701975-131

For use in Canada 701975-DB1 For use in Romania 701975-271

For use in the Czech Republic
and Slovakia

701975-FL1 For use in Russia 701975-251

For use in Denmark 701975-081 For use in Saudi Arabia 701975-171

For use in France 701975-051 For use in Slovenia 701975-BA1

For use in Germany 701975-041 For use in South Korea 701975-AD1

For use in Greece 701975-151 For use in Spain 701975-071

For use in Hungary 701975-211 For use in Sweden and Finland 701975-B71

For use in Iceland 701975-DD1 For use in Switzerland 701975-BG1

For use in India 701975-D61 For use in Taiwan 701975-AB1

For use in Israel 701975-BB1 For use in Thailand 701975-281

For use in Italy 701975-061 For use in Turkey 701975-141

For use in Japan 701975-291 For use in the United Kingdom
and Singapore

701975-031

For use in Latin America 701975-161 For use in the United States 701975-001

For use only on computer models equipped with the
Windows 7 operating system:

For use in the Netherlands 684332-B31

For use in Belgium 684332-A41 For use in Norway 684332-091

For use in Brazil 684332-201 For use in Northwest Africa 684332-FP1

For use in Bulgaria 684332-261 For use in Portugal 684332-131

For use in Canada 684332-DB1 For use in Romania 684332-271

For use in the Czech Republic
and Slovakia

684332-A81 For use in Russia 684332-251

For use in Denmark 684332-081 For use in Saudi Arabia 684332-171

For use in France 684332-051 For use in Slovenia 684332-BA1

For use in Germany 684332-041 For use in South Korea 684332-AD1

88 Chapter 4   Removal and replacement procedures



For use in country/region Spare part
number

For use in country/region Spare part
number

For use in Greece 684332-DJ1 For use in Spain 684332-071

For use in Hungary 684332-211 For use in Sweden and Finland 684332-B71

For use in Iceland 684332-DD1 For use in Switzerland 684332-BG1

For use in India 684332-D61 For use in Taiwan 684332-AB1

For use in Israel 684332-BB1 For use in Thailand 684332-281

For use in Italy 684332-061 For use in Turkey 684332-141

For use in Japan 684332-291 For use in the United Kingdom
and Singapore

684332-031

For use in Latin America 684332-161 For use in the United States 684332-001

Keyboard without pointing stick (includes keyboard cable):

For use only on computer models equipped with the
Windows 8 operating system:

For use in the Netherlands 701976-B31

For use in Belgium 701976-A41 For use in Norway 701976-091

For use in Brazil 701976-201 For use in Northwest Africa 701976-FP1

For use in Bulgaria 701976-261 For use in Portugal 701976-131

For use in Canada 701976-DB1 For use in Romania 701976-271

For use in the Czech Republic
and Slovakia

701976-FL1 For use in Russia 701976-251

For use in Denmark 701976-081 For use in Saudi Arabia 701976-171

For use in France 701976-051 For use in Slovenia 701976-BA1

For use in Germany 701976-041 For use in South Korea 701976-AD1

For use in Greece 701976-151 For use in Spain 701976-071

For use in Hungary 701976-211 For use in Sweden and Finland 701976-B71

For use in Iceland 701976-DD1 For use in Switzerland 701976-BG1

For use in India 701976-D61 For use in Taiwan 701976-AB1

For use in Israel 701976-BB1 For use in Thailand 701976-281

For use in Italy 701976-061 For use in Turkey 701976-141

For use in Japan 701976-291 For use in the United Kingdom
and Singapore

701976-031

For use in Latin America 701976-161 For use in the United States 701976-001

For use only on computer models equipped with the
Windows 7 operating system:

For use in the Netherlands 684333-B31

For use in Belgium 684333-A41 For use in Norway 684333-091

For use in Brazil 684333-201 For use in Northwest Africa 684333-FP1
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For use in country/region Spare part
number

For use in country/region Spare part
number

For use in Bulgaria 684333-261 For use in Portugal 684333-131

For use in Canada 684333-DB1 For use in Romania 684333-271

For use in the Czech Republic
and Slovakia

684333-A81 For use in Russia 684333-251

For use in Denmark 684333-081 For use in Saudi Arabia 684333-171

For use in France 684333-051 For use in Slovenia 684333-BA1

For use in Germany 684333-041 For use in South Korea 684333-AD1

For use in Greece 684333-DJ1 For use in Spain 684333-071

For use in Hungary 684333-211 For use in Sweden and Finland 684333-B71

For use in Iceland 684333-DD1 For use in Switzerland 684333-BG1

For use in India 684333-D61 For use in Taiwan 684333-AB1

For use in Israel 684333-BB1 For use in Thailand 684333-281

For use in Italy 684333-061 For use in Turkey 684333-141

For use in Japan 684333-291 For use in the United Kingdom
and Singapore

684333-031

For use in Latin America 684333-161 For use in the United States 684333-001

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68).

5. Remove the service cover (see Service cover on page 70).
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Remove the keyboard:

1. Loosen the three Phillips captive screws that secure the keyboard to the computer.

2. Rest and secure the computer on its right side.

3. Partially open the computer.

4. Insert a screw driver or similar thin tool into the keyboard release opening in the battery bay,
and then press on the back of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.
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6. Lift the rear edge of the keyboard (1), and then swing the keyboard up and forward (2) until it
rests upside down on the palm rest.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached,
and then disconnect the keyboard cable (2) from the keyboard.

NOTE: The pointing stick cable is present on select models only.

8. Release the ZIF connector (3) to which the pointing stick cable is attached, and then disconnect
the pointing stick cable (4) from the system board.

9. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Base enclosure

NOTE: The base enclosure spare part kit includes seven rubber feet, the service cover release latch
assembly, and the battery release latch assembly.

Description Spare part number

For use only on computer models equipped with WWAN capability 684334-001

For use only on computer models not equipped with WWAN capability 687224-001

Before removing the base enclosure, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Optical drive (see Optical drive on page 71)

c. Hard drive (see Hard drive on page 74)

d. Modem module (see Modem module on page 85)

e. Keyboard (see Keyboard on page 88)

NOTE: When replacing the base enclosure, be sure to remove the following components from the
defective base enclosure and install them on the replacement base enclosure:

● Bluetooth module and cable (see Bluetooth module on page 84)

● Speaker assembly (see Speaker assembly on page 97)

● RJ-11 jack assembly (see RJ-11 jack cable on page 98)

Remove the base enclosure:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.

3. Remove the three rubber screw covers (1) and (2). The rubber screw covers are included in the
Rubber Kit, spare part number 641831-001.

NOTE: The rubber screw covers in the front/right and rear/left corners (1) are smaller than the
screw cover in the rear/right corner.

4. Remove the seven Torx PM2.5×6.0 screws (3) that secure the base enclosure to the computer.
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5. Remove the four Phillips PM2.5×3.0 screws from the battery bay (4) that secure the base
enclosure to the computer.

6. Remove the two Phillips PM2.5×3.0 screws (1) from the hard drive bay that secure the base
enclosure to the computer.

7. Remove the three Phillips PM2.0×3.0 screws (2) from the optical drive bay that secure the base
enclosure to the computer.

8. Position the computer with the battery bay toward you.
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9. Remove the four Torx TM2.5×8.0 screws from the rear panel of the computer.

10. Remove the wireless cables from the clips (1) and routing channel built into the base enclosure.

11. Disconnect the speaker cable (2) from the system board.
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12. Remove the base enclosure by lifting it straight up from the computer.

NOTE: When replacing the bottom cover, make sure to remove the RJ-11 jack cover from the slot in
the base enclosure if the repaired unit includes a modem.

NOTE: Thoroughly clean the thermal pad material from the surfaces of the base enclosure (1)
and the PCH chip (2) each time you remove the base enclosure. All base enclosure and system board
spare part kits include replacement thermal pad material.

Reverse this procedure to install the base enclosure.
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Speaker assembly

Description Spare part number

Speaker assembly (includes cable) 641840-001

Before removing the speaker assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Optical drive (see Optical drive on page 71)

c. Hard drive (see Hard drive on page 74)

d. Modem module (see Modem module on page 85)

e. Keyboard (see Keyboard on page 88)

f. Base enclosure (see Base enclosure on page 93)

Remove the speaker assembly:

1. Turn the base enclosure right-side up, with the front toward you.

2. Remove the two Phillips PM2.0×3.0 screws (1) that secure the speaker assembly to the
base enclosure.
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3. Remove the speaker assembly (2) from the base enclosure.

Reverse this procedure to install the speaker assembly.

RJ-11 jack cable

NOTE: The RJ-11 jack cable is included in the Cable Kit, spare part number 641830-001.

Before removing the RJ-11 jack cable, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Optical drive (see Optical drive on page 71)

c. Hard drive (see Hard drive on page 74)

d. Modem module (see Modem module on page 85)

e. Keyboard (see Keyboard on page 88)

f. Base enclosure (see Base enclosure on page 93)
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Remove the RJ-11 jack cable:

1. Turn the base enclosure right-side up, with the front toward you.

2. Release the RJ-11 jack from the clip (1) built into the base enclosure.

3. Release the RJ-11 jack cable from the clips (2) and routing channel built into the base enclosure.

4. Remove the RJ-11 jack cable.

Reverse this procedure to install the RJ-11 jack cable.

Service cover release latch assembly

NOTE: The service cover release latch assembly components are included in the Latch Kit, spare part
number 684339-001.

Before removing the service cover release latch assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Optical drive (see Optical drive on page 71)

c. Hard drive (see Hard drive on page 74)

d. Modem module (see Modem module on page 85)
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e. Keyboard (see Keyboard on page 88)

f. Base enclosure (see Base enclosure on page 93)

Remove the service cover release latch assembly:

1. Position the base enclosure with the front toward you.

2. Remove the service cover release latch actuator from the base enclosure.

3. Turn the base enclosure right side up, with the front toward you.

4. Remove the service cover release latch arm spring from the spring retention hooks on the service
cover release latch arm (1) and the base enclosure (2).

5. Slide the service cover release latch arm (1) as far to the left as it will go.

6. Flex the middle of the service cover release latch arm (2) up and back until it releases from the
track built into the base enclosure.
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7. Lift the left end of the service cover release latch arm (3) out of the openings in the base enclosure.

8. Swing the left end of the service cover release latch arm (1) toward the back of the computer.

9. Release the right end of the service cover release latch arm (2) from the openings in the
base enclosure.

10. Remove the service cover release latch arm.

Reverse this procedure to install the service cover release latch assembly.
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Battery release latch assembly

NOTE: The battery release latch assembly components are included in the Latch Kit, spare part
number 684339-001.

Before removing the battery release latch assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Optical drive (see Optical drive on page 71)

c. Hard drive (see Hard drive on page 74)

d. Modem module (see Modem module on page 85)

e. Keyboard (see Keyboard on page 88)

f. Base enclosure (see Base enclosure on page 93)

Remove the battery release latch assembly:

1. Position the base enclosure with the front toward you.

2. Remove the battery release latch actuator from the base enclosure.

3. Turn the base enclosure right side up, with the front toward you.
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4. Remove the battery release latch arm spring from the spring retention hooks on the
base enclosure (1) and the battery release latch arm (2).

5. Slide the battery release latch arm (1) as far to the right as it will go.

6. Lift the right end of the battery release latch arm (2) until it is clear of the retention post built into
the base enclosure.

7. Swing the right end of the battery release latch arm (3) clockwise until it is clear of the retention
post built into the base enclosure.

8. Slide the battery release latch arm (1) as far to the left as it will go.
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9. Swing the right end of the battery release latch arm (2) clockwise until the left end of the arm
release from the openings in the base enclosure.

10. Remove the battery release latch arm.

Reverse this procedure to install the battery release latch assembly.

Function board

Description Spare part number

Function board 658142-001

Before removing the function board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Optical drive (see Optical drive on page 71)

c. Hard drive (see Hard drive on page 74)

d. Modem module (see Modem module on page 85)

e. Keyboard (see Keyboard on page 88)

f. Base enclosure (see Base enclosure on page 93)
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Remove the function board:

1. Remove the wireless antenna cables (1) from the retention clip attached to the system board.

2. Remove the three Phillips PM2.5×7.0 screws (2) that secure the function board to the computer.

3. Slide the function board (3) to the left, and then remove the function board.

Reverse this procedure to install the function board.
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System board

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use only on HP ProBook 6475b Notebook PC computer models:

For use on computer models equipped with the Windows 8 Professional operating system
and WWAN capability in all countries and regions except in the People's Republic of China
and the Ukraine

684341-601

For use on computer models equipped with the Windows 8 Standard operating system
and WWAN capability in all countries and regions except in the People's Republic of China
and the Ukraine

684341-501

For use on computer models equipped with the Windows 7 operating system and WWAN
capability in all countries and regions except in the People's Republic of China and the Ukraine

684341-001

For use on computer models equipped with the Windows 8 Professional operating system but
without WWAN capability in all countries and regions except in the People's Republic of China
and the Ukraine

684342-601

For use on computer models equipped with the Windows 8 Standard operating system but without
WWAN capability in all countries and regions except in the People's Republic of China
and the Ukraine

684342-501

For use on computer models equipped with the Windows 7 operating system but without WWAN
capability in all countries and regions except in the People's Republic of China and the Ukraine

684342-001

For use on computer models equipped with the Windows 7 operating system and WWAN
capability only in the People's Republic of China and the Ukraine

690036-001

For use on computer models equipped with the Windows 7 operating system but not WWAN
capability only in the People's Republic of China and the Ukraine

690037-001

For use only on HP ProBook 6470b Notebook PC computer models:

For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem with
discrete memory, the Windows 8 Professional operating system, and WWAN capability in all
countries and regions except in the People's Republic of China and the Ukraine

686039-601

For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem with
discrete memory, the Windows 8 Standard operating system, and WWAN capability in all
countries and regions except in the People's Republic of China and the Ukraine

686039-501

For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem with
discrete memory, the Windows 7 operating system, and WWAN capability in all countries
and regions except in the People's Republic of China and the Ukraine

686039-001

For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem with
UMA memory, the Windows 8 Professional operating system, and WWAN capability in all
countries and regions except in the People's Republic of China and the Ukraine

686037-601

For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem with
UMA memory, the Windows 8 Standard operating system, and WWAN capability in all countries
and regions except in the People's Republic of China and the Ukraine

686037-501

For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem with
UMA memory, the Windows 7 operating system, and WWAN capability in all countries
and regions except in the People's Republic of China and the Ukraine

686037-001
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Description Spare part number

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
discrete memory, the Windows 8 Professional operating system, and WWAN capability in all
countries and regions except in the People's Republic of China and the Ukraine

686038-601

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
discrete memory, the Windows 8 Standard operating system, and WWAN capability in all
countries and regions except in the People's Republic of China and the Ukraine

686038-501

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
discrete memory, the Windows 7 operating system, and WWAN capability in all countries
and regions except in the People's Republic of China and the Ukraine

686038-001

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
UMA memory, the Windows 8 Professional operating system, and WWAN capability in all
countries and regions except in the People's Republic of China and the Ukraine

686036-601

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
UMA memory, the Windows 8 Standard operating system, and WWAN capability in all countries
and regions except in the People's Republic of China and the Ukraine

686036-501

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
UMA memory, the Windows 7 operating system, and WWAN capability in all countries
and regions except in the People's Republic of China and the Ukraine

686036-001

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
UMA memory, and the Windows 8 Professional operating system, but without WWAN capability
in all countries and regions except in the People's Republic of China and the Ukraine

686035-601

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
UMA memory, and the Windows 8 Standard operating system, but without WWAN capability in
all countries and regions except in the People's Republic of China and the Ukraine

686035-501

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
UMA memory, and the Windows 7 operating system, but without WWAN capability in all
countries and regions except in the People's Republic of China and the Ukraine

686035-001

For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem with
discrete memory, the Windows 7 operating system, and WWAN capability only in the People's
Republic of China and the Ukraine

691715-001

For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem with
UMA memory, the Windows 7 operating system, and WWAN capability only in the People's
Republic of China and the Ukraine

691713-001

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
discrete memory, the Windows 7 operating system, and WWAN capability only in the People's
Republic of China and the Ukraine

691714-001

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
UMA memory, the Windows 7 operating system, and WWAN capability only in the People's
Republic of China and the Ukraine

691712-001

For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem with
UMA memory, the Windows 7 operating system, but without WWAN capability only in the
People's Republic of China and the Ukraine

691711-001
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Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Optical drive (see Optical drive on page 71)

c. Hard drive (see Hard drive on page 74)

d. Fan (see Fan on page 87)

e. Modem module (see Modem module on page 85)

f. Fan (see Fan on page 87)

g. Keyboard (see Keyboard on page 88)

h. Base enclosure (see Base enclosure on page 93)

NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● SIM (see SIM on page 69, if applicable)

● Memory module (see Memory module on page 77)

● WWAN module (see WWAN module on page 80)

● WLAN module (see WLAN module on page 82)

● Heat sink (see Heat sink on page 111)

● Processor (see Processor on page 114)

Remove the system board:

1. Position the computer right-side up, with the front toward you.

2. Open the computer.

3. Release the ZIF connector (1) to which the TouchPad cable is connected, and then disconnect the
TouchPad cable (2) from the system board.

4. Release the ZIF connector (3) to which the fingerprint reader board cable is connected, and then
disconnect the fingerprint reader board cable (4) from the system board.
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5. Disconnect the power connector cable (5) from the system board.

6. Close the computer.

7. Turn the computer upside down, with the battery bay toward you.

8. Remove the Phillips PM2.5×5.0 screw (1) that secures the display panel cable ground loop (2) to
the computer.

9. Release the display panel cable (3) from the retention clip (4) attached to the system board.
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10. Disconnect the display panel cable (5) from the system board.

11. Remove the four Phillips PM2.5×5.0 screws that secure the system board to the top cover.

12. Lift the right side of the system board (1) until it rests at an angle.
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13. Remove the system board (2) by sliding it up and to the right at an angle.

Reverse this procedure to install the system board.

Heat sink

NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number

Heat sink for use only on HP ProBook 6475p Notebook PC computer models 658543-001

Heat sink for use only on HP ProBook 6470b Notebook PC computer models equipped with a
graphics subsystem with discrete memory

686021-001

Heat sink for use only on HP ProBook 6470b Notebook PC computer models equipped with a
graphics subsystem with UMA memory

693371-001

Before removing the heat sink, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Hard drive (see Hard drive on page 74)

c. Optical drive (see Hard drive on page 74)
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d. WLAN module (see WLAN module on page 82)

e. WWAN module (see WWAN module on page 80)

f. Fan (see Fan on page 87)

g. Keyboard (see Keyboard on page 88)

h. Base enclosure (see Base enclosure on page 93)

i. System board (see System board on page 106)

Remove the heat sink:

NOTE: Steps 1 and 2 apply to computer models equipped with a graphics subsystem with discrete
memory. See steps 3 and 4 for heat sink removal information for computer models equipped with a
graphics subsystem with UMA memory.

1. Following the 1, 2, 3, 4, 5, 6 sequence stamped into the heat sink, loosen the six captive Philllips
screws (1) and (2) that secure the heat sink to the system board.

2. Remove the heat sink (3).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink
and the system board components, it may be necessary to move the heat sink from side to side to
detach it.

NOTE: Steps 3 and 4 apply to computer models equipped with a graphics subsystem with UMA
memory. See steps 1 and 2 for heat sink removal information for computer models equipped with
a graphics subsystem with discrete memory.
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3. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips
screws (1) that secure the heat sink to the system board.

4. Remove the heat sink (2).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink
and the system board components, it may be necessary to move the heat sink from side to side to
detach it.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
and the system board components each time the heat sink is removed. Replacement
thermal material is included with the heat sink, processor, and system board spare part kits.

The following illustration shows the replacement thermal material locations on a computer model
equipped with a graphics subsystem with discrete memory.

● Thermal paste is used on the processor (1) and the heat sink section (2) that services it

● A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it
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The following illustration shows the replacement thermal material locations on a computer model
equipped with a graphics subsystem with UMA memory. Thermal paste is used on the processor
(1) and the heat sink section (2) that services it.

Reverse this procedure to install the heat sink.

Processor

NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

For use only on HP ProBook 6475b Notebook PC computer models:

AMD A10-4600M 3.20-GHz/2.30-GHz processor with Radeon HD 7660G graphics (4.0-MB L2
cache, 1600-MHz DDR3, quad core, 35 W)

683046-001

AMD A8-4500M 2.80-GHz/1.90-GHz processor with Radeon HD 7640G graphics (4.0-MB L2
cache, 1600-MHz DDR3, quad core, 35 W)

683048-001

AMD A6-4400M 3.20-GHz/2.70-GHz processor with Radeon HD 7520G graphics (1.0-MB L2
cache, 1600-MHz DDR3, dual core, 35 W)

683047-001
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Description Spare part number

AMD A4-4300M 3.00-GHz/2.50-GHz processor with Radeon HD 7420G graphics (1.0-MB L2
cache, 1600-MHz DDR3, dual core, 35 W)

685990-001

For use only on HP ProBook 6470b Notebook PC computer models:

Intel Quad Core i7-3540M 3.00-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 4.0-
MB L3 cache, 35 W)

710787-001

Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0-
MB L3 cache, 35 W)

681954-001

Intel Dual Core i5-3380M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

708762-001

Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

681953-001

Intel Dual Core i5-3340M 2.70-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

708761-001

Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

711903-001

Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

680645-001

Intel Core i3-3130M 2.60-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 713163-001

Intel Core i3-3120M 2.50-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 700627-001

Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001

Intel Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 677152-001

Intel Celeron B840 1.90-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, 35 W) 664663-001

Before removing the processor, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Hard drive (see Hard drive on page 74)

c. Optical drive (see Hard drive on page 74)

d. WLAN module (see WLAN module on page 82)

e. WWAN module (see WWAN module on page 80)

f. Fan (see Fan on page 87)

Component replacement procedures 115



g. Keyboard (see Keyboard on page 88)

h. Base enclosure (see Base enclosure on page 93)

i. System board (see System board on page 106)

j. Heat sink (see Heat sink on page 111)

Remove the processor:

1. Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise, until you hear a click.

2. Lift the processor (2) straight up, and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)
embossed on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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USB board

Description Spare part number

USB board 658141-001

Before removing the USB board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Optical drive (see Optical drive on page 71)

c. Hard drive (see Hard drive on page 74)

d. Modem module (see Modem module on page 85)

e. Keyboard (see Keyboard on page 88)

f. Base enclosure (see Base enclosure on page 93)

g. System board (see System board on page 106)

Remove the USB board:

1. Release the clip (1) built into the top cover that secures the left side of the USB board.

2. Lift the left side of the USB board (2) to disconnect the USB board from the system board.
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3. Remove the USB board (3).

Reverse this procedure to install the USB board.
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Display assembly

NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 68), and then remove the following components:

a. Service cover (see Service cover on page 70)

b. Hard drive (see Hard drive on page 74)

c. Optical drive (see Hard drive on page 74)

d. WLAN module (see WLAN module on page 82)

e. WWAN module (see WWAN module on page 80)

f. Fan (see Fan on page 87)

g. Keyboard (see Keyboard on page 88)

h. Base enclosure (see Base enclosure on page 93)

i. Function board (see Function board on page 104)

j. System board (see System board on page 106)

Remove the display assembly:

1. Position the computer with the front toward you.

2. Remove the four Phillips PM2.5×7.0 screws (1) that secure the display assembly to the computer.

3. Swing the display hinges (2) up and back until the top cover is free for removal.
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4. Remove the top cover (3) from the display assembly.

5. If it is necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the rubber screw covers (1). The rubber screw covers are available in the Display
Rubber Kit, spare part number 642785-001.

b. Remove the two Phillips PM2.5×5.0 screws (2) that secure the display bezel to the
display assembly.

c. Flex the inside edges of the bottom edge (1), the left and right sides (2), and the
top edge (3) of the display bezel until the bezel disengages from the display enclosure.
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d. Remove the display bezel (4).

The display bezel is available using spare part numbers 683781-001 (for use only on HP
ProBook 6475b Notebook PC computer models computer models) and 685999-001 (for use
only on HP ProBook 6470b Notebook PC computer models computer models).

6. If it is necessary to replace the webcam/microphone module:

CAUTION: Handle the webcam/microphone module with caution. The module has a thin
profile and is susceptible to damage when not handled carefully.

a. Detach the webcam/microphone module (1) from the display enclosure. (The webcam/
microphone module is attached to the display enclosure with double-sided tape.)

b. Disconnect the webcam/microphone module cable (2) from the webcam/
microphone module.

Component replacement procedures 121



c. Remove the webcam/microphone module (3).

The webcam/microphone module is available using spare part number 684346-001. The
microphone module is available using spare part number 684346-001.

7. If it is necessary to replace the display panel:

a. Remove the eight Phillips PM2.5×4.0 screws (1) that secure the display panel to the
display enclosure.

b. Lift the top edge of the display panel (2) until the display panel rests at an angle.

c. Remove the display panel (3).

The display panel is available using the following spare part numbers.

● 686047-001 — 14.0-in, LED, FLT, HD+, AntiGlare display panel for use on all
computer models

● 686046-001 — 14.0-in, LED, FLT, HD, AntiGlare display panel for use on all computer
models

● 684348-001 — 14.0-in, LED, SVA, HD+, AntiGlare display panel for use only on HP
ProBook 6470b Notebook PC computer models

● 684347-001 — 14.0-in, LED, SVA, HD, AntiGlare display panel for use only on HP
ProBook 6470b Notebook PC computer models
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8. If it is necessary to replace the display hinge covers:

a. Remove the two Phillips PM2.5×3.0 screws (1) that secure the display hinge covers to the
display hinges.

b. Slide the display hinge covers (2) toward each other to remove them from the display hinges.

The display hinge covers are available using spare part number 642783-001.

9. If it is necessary to replace the display hinges:

a. Remove the four Phillips PM2.5×3.0 screws (1) that secure the display hinges to the
display enclosure.
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b. Remove the display hinges (2) from the display panel.

The display hinges are available using spare part number 641836-001.

10. If it is necessary to replace the display panel cable:

CAUTION: Before turning the display panel upside down, make sure the work surface is clear
of tools, screws, and any other foreign objects. Failure to follow this caution can result in damage
to the display panel.

a. Turn the display panel upside down, with the display panel cable toward you.

b. Release the adhesive support strip (1) that secures the display panel cable to the display
panel.
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c. Disconnect the display panel cable (2) from the display panel.

d. Remove the display panel cable.

The display panel cable is available using spare part numbers 693064-001 (for use only on
computer models equipped with an HD+ display assembly) and 693063-001 (for use only
on computer models equipped with an HD display assembly).

11. If it is necessary to replace the WLAN antenna cables and transceivers:

a. Release the WLAN antenna cables from the clips (1) and routing channel built into the
display enclosure.

b. Detach the WLAN antenna transceivers (2) from the display enclosure. (The WLAN antenna
transceivers are attached to the display enclosure with double-sided tape.)
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c. Remove the WLAN antenna cables and transceivers (3). The WLAN antenna cables
and transceivers are included in the Antenna Kit, spare part number 642799-001.

12. If it is necessary to replace the WWAN antenna cables and transceivers:

a. Release the WWAN antenna cables from the clips (1) and routing channel built into the
display enclosure.

b. Detach the WWAN antenna transceivers (2) from the display enclosure. (The WWAN
antenna transceivers are attached to the display enclosure with double-sided tape.)

c. Remove the WWAN antenna cables and transceivers (3). The WWAN antenna cables
and transceivers are included in the Antenna Kit, spare part number 642801-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) and
Advanced System Diagnostics

Windows 8

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.
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Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type h, and then select Help and Support.

2. In the Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then click File Explorer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

● BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to
main menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: NOTE: you need to stop a diagnostics test while it is running, press esc.
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Windows 7
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your Web browser. For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.
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3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. 1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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SuSE Linux (SLED)
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –
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Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For
worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 33.80 cm 13.31 in

Depth 23.13 cm 9.11 in

Height (front to back) 3.40 to 3.60 cm 1.34 to 1.42 in

Weight

Equipped with 9-cell battery, optical drive, graphics
subsystem with UMA memory, one memory module,
WLAN module, solid-state drive, and TouchPad

2.47 kg 5.45 lbs

Equipped with 9-cell battery, graphics subsystem with
UMA memory, one memory module, WLAN module,
solid-state drive, and TouchPad

2.33 kg 5.14 lbs

Equipped with 6-cell battery, optical drive, graphics
subsystem with UMA memory, one memory module,
WLAN module, solid-state drive, and TouchPad

2.31 kg 5.09 lbs

Equipped with 6-cell battery, graphics subsystem with
UMA memory, one memory module, WLAN module,
solid-state drive, and TouchPad

2.17 kg 4.78 lbs

Equipped with 6-cell battery, optical drive, graphics
subsystem with UMA memory, one memory module,
WLAN module, solid-state drive, and TouchPad

2.17 kg 4.78 lbs

Equipped with 6-cell battery, graphics subsystem with
UMA memory, one memory module, WLAN module,
solid-state drive, and TouchPad

2.03 kg 4.48 lbs

Input power

Operating voltage and current 18.5 V dc @ 3.5 A - 65 W

– or –

19.0 V dc @ 4.74 A - 90 W

Temperature
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 Metric U.S.

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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14.0-inch SGA display specifications

 Metric U.S.

Dimensions

Height 17.6 cm 6.93 in

Width 31.2 cm 12.28 in

Diagonal 35.7 cm 14.06 in

Number of colors up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format HD+, SVA (1600 x 1900)

HD, SVA (1366 x 768)

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 3.46 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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Hard drive specifications

 750-GB* 500-GB* 320-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Length 100.2 mm 100.4 mm 100.4 mm

Width 69.9 mm 69.9 mm 69.9 mm

Weight 110 g 110 g 110 g

Interface type SATA SATA SATA

Transfer rate

Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 2.0 ms 1.5 ms 1.5 ms

Average (read/write) 12/16 ms 11/13 ms 11/13 ms

Maximum 22 ms 22 ms 22 ms

Logical blocks 1,465,149,168 976,773,168 628,142,448

Disk rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Windows 8
To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system restore
points. In case of system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information. From the Start
screen, type h, and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. As you add new software and data files, you should continue to back up your system
on a regular basis to maintain a reasonably current backup. The system repair media (select models
only) are used to start up (boot) the computer and repair the operating system in case of system
instability or failure. Your initial and subsequent backups allow you to restore your data and settings if
a failure occurs.

From the Start screen, type backup, click Settings, and then select Save backup copies of your
files with File History.

You can back up your information to an optional external hard drive or a network drive.
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Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. From the Start screen, type backup, click Settings, and then select from the list of
displayed options.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see the
“Using Windows 8 operating system media (purchased separately)” section.

Using the Windows recovery tools

To recover information you previously backed up:

▲ From the Start screen, type h, and then select Help and Support.

To recover your information using Startup Repair, follow these steps:
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CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition.

From the Start screen, type e, and then click File Explorer.

– or –

From the Start screen, type c, and then select Computer.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see the “Using Windows
8 operating system media (purchased separately)” section.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select
Help and Support.

Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type c, and
then select Computer.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see the “Using Windows 8 operating system
media (purchased separately)” section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.
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4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on reinstalling
traditional applications. From the Start screen, type h, and then select Help and Support.

NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select
Help and Support.
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To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the
on-screen instructions.

Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, apps, and settings from your computer, and reinstalls Windows.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key or from the Start screen.

To use the f11 key:

1. Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Remove everything and reinstall Windows, select Get started, and follow the
on-screen instructions.
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Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted
from the system.

1. From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only) with
the installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of
your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

● Backing up your information

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media allows you to reinstall your original operating system as well as
select drivers and applications if the hard drive becomes corrupted.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:

● Windows DVD—Installs the operating system without additional drivers or applications.

● Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media

NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will
not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver DVD or Windows DVD.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Burn button to start the burning process.

Backing up your information

Recovery after a system failure is as good as your most recent backup. Immediately after setting up the
computer, you should create system repair discs (select models only) using the installed optical drive
(select models only) or an optional external optical drive and back up your system. As you add new
software and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive you are using.
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NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select
models only), or create a system repair disc (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see the Using a
Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select
models only), or your files.

To recover your information using Startup Repair, follow these steps:

CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the hard
drive. All files you have created and any software installed on the computer are permanently removed.
When reformatting is complete, the recovery process restores the operating system, as well as the
drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.
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3. If the Windows partition is listed, restart the computer, and then press f8 before the Windows
operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools

CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11>” for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/
us/en/ wwcontact_us.html. You can also order the DVD by calling support. For contact information,
see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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SuSE Linux (SLED)
Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if
ever needed.

Creating backups

1. Create restore media immediately after you set up the computer. For more information, see the
“Performing a system recovery” section.

2. As you add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click
Backup my home directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled
time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.
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4. To restore all files from the selected location, click Restore all files. To restore select files only,
click Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

NOTE: If multiple backups have been performed, click Use the latest version to restore the
latest version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image Restore DVD, using an installed or an external DVD±RW optical drive.

CAUTION: CAUTION: Using Recovery completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The recovery tool reinstalls the original operating system and HP programs and drivers that were
installed at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To restore the computer using the HP Factory Image Restore DVD, you must first create the recovery
disc. To create the recovery disc:

NOTE: HP recommends that you create the HP Factory Image Restore DVD in the event of a system
failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the
right pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot
menu, and then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-
Restore?

6. Follow the on-screen instructions.
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USB Recovery option (select models only)

The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the SLED
operating system installed on select HP Business Notebooks. This Disk On Key may be used to restore
the system to the original factory state when the F11 recovery option is not available. This process
should be done on first obtaining the computer.

CAUTION: The USB recovery option does not preserve data present on the computer’s hard drive or
on the Disk On Key used for the recovery process. Back up any data on the Disk on Key or the
notebook that will be recovered before starting.

NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure. The
Disk On Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key

1. Connect the USB Disk On Key to a USB port on the computer.

2. Select Computer > More applications > Tools > Create Recovery USB.

3. Enter the root password when prompted.

4. Select USB Disk On Key from the list.

5. Click OK.

6. A question dialog will remind you that the data on the USB key will be destroyed. To continue,
click OK. Otherwise, click Cancel and back up the contents of the Disk On Key on another
computer.

7. The backup process will display a status dialog box while the backup is in progress.

NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the
key is mounted. You may close the file browser window if desired. Once the USB Recovery Key
has been created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

CAUTION: Before starting the Recovery process, make sure any data on the system to be recovered
has been backed up. The recovery process destroys all data on the system to be recovered.

1. Turn off the computer.

2. Connect the USB Disk On Key to a USB port on the computer.

3. Turn on the computer while holding down the f9 key.

4. Once the system has booted, the Boot Options menu should appear.

5. Using the arrow keys, select USB Disk On Key and press enter.

NOTE: The description may vary from one USB key to another. Any entry other than Optical
Disk Drive, Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On Key.

6. Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk On
Key will boot.
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7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start
the System-Restore?” If data on the computer has not been backed up, use the tab key and select
No. The system will reboot. Back up the system data and repeat the previous steps. If no data
should be saved from the computer, use the tab key to select Yes. Press enter to begin the
recovery process.

8. After the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall SLED

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, applications, and settings from your computer, and reinstalls the Linux operating
system.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

The following options are available:

● Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

● Recover/Repair System—This option repairs a system that is not working properly and preserves
user data.

● Restore Factory System—This option restores the system back to the original factory state. User
data is not preserved.

Select an option and follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.

160 Chapter 9   Recycling

http://www.hp.com/recycle


Index

Symbols/Numerics
1394 port 22

A
AC adapter, spare part numbers

46, 56
AC adapter/battery light 21
accessory battery connector 25
antenna

locations 15
removal 125, 126
spare part numbers 41, 48,

126
audio, product description 6
audio-in jack 23
audio-out jack 23

B
base enclosure

removal 93
spare part numbers 37, 53,

55, 93
battery

removal 68
spare part numbers 38, 47,

48, 49, 68
battery bay 25
battery release latch 25
battery release latch assembly

removal 102
spare part number 102

Blu-ray ROM DVD±RW SuperMulti
DL Drive

precautions 62
removal 71
spare part number 38, 45,

49, 71
Bluetooth compartment, location

26

Bluetooth module
removal 84
spare part number 38, 48, 84

Bluetooth module cable,
illustrated 42

bottom components 25
button components 17
buttons

optical drive eject 23
pointing stick 20, 21
power 17
TouchPad 21
TouchPad on/off 17, 20
volume mute 18
Web browser 18
wireless 17

C
Cable Kit

components 42
spare part number 42, 48

cables, service considerations 61
caps lock light 19
carrying case, spare part

numbers 46, 47
chipset, product description 2
components

bottom 25
buttons 17
display 15
fingerprint reader 17
front 21
keys 18
left-side 22
lights 19
Rear 24
right-side 23
TouchPad 20

computer feet
location 67
spare part number 67

computer major components 29
computer part number 66
computer specifications 140
connectors, service

considerations 61

D
display

components 15
specifications 142

display assembly
removal 119
subcomponents 40

display bezel
removal 120
spare part numbers 41, 49,

54, 121
Display Cable Kit, spare part

numbers 41, 56, 125
display enclosure, spare part

number 41, 48
display hinge

removal 123
spare part number 41, 48,

124
display hinge cover

removal 123
spare part number 48, 123

Display Hinge Cover Kit, spare part
number 41, 48, 123

Display Hinge Kit, spare part
number 41, 48, 124

Display Miscellaneous Kit, spare
part number 41, 56

display panel
product description 4

Index 161



removal 122
spare part numbers 41, 53,

55, 122
display panel cable

removal 124
spare part numbers 41, 56,

125
Display Panel Support Kit, spare

part number 41, 49
display release latch 21
Display Rubber Kit, spare part

number 41, 48
display switch, location 15
DisplayPort 23
docking connector, location 25
drives, preventing damage 62
DVD-ROM Drive

precautions 62
removal 71
spare part number 38, 45,

49, 71
DVD±RW Double-Layer with

SuperMulti Drive
precautions 62
removal 71
spare part number 38, 45,

49, 71

E
electrostatic discharge 62
equipment guidelines 65
eSATA port 23
Ethernet, product description 6
ExpressCard slot 22
ExpressCard slot space saver,

illustrated 43
external monitor jack 24

F
fan

removal 87
spare part number 34, 48, 87

feet
location 67
spare part number 67

fingerprint reader 18
fingerprint reader component 17
flash cache

product description 4

flash cache module, spare part
number 45, 55

fn key 18
front component 21
function board

removal 104
spare part number 37, 104

function keys 18

G
graphics, product description 3
grounding guidelines 62
guidelines

equipment 65
grounding 62
packaging 64
transporting 64
workstation 64

H
hard drive

precautions 62
product description 5
removal 74
spare part numbers 39, 44,

48, 49, 74
specifications 143

hard drive bracket
illustrated 44
removal 75

Hard Drive Hardware Kit
contents 44
spare part number 39, 44,

48, 74
hard drive light 22
headphone jack 23
heat sink

removal 111
spare part numbers 34, 49,

54, 56, 111

J
jacks

audio-in 23
audio-out 23
external monitor 24
headphone 23
microphone 23
modem 24
monitor 24
network 24

RJ-11 24
RJ-45 24

K
key components 18
keyboard

product description 9
remval 88
spare part numbers 30, 32,

50, 51, 52, 53, 56, 57, 58,
59, 60, 88

keys
fn 18
function 18
num lk 19
perating system applications

18
perating system logo 18

L
Latch Kit, spare part number 37,

53, 99, 102
left-side components 22
light components 19
lights

AC adapter/battery 21
caps lock 19
hard drive 22
mute 20
num lock 20
power 19, 21
TouchPad 19
Web browser 20
webcam 15
wireless 19, 21

lock, spare part numbers 46, 47

M
mass storage device

illustrated 44
precautions 62
spare part numbers 44

Media Card Reader, location 22
memory module

product description 4
removal 77
spare part numbers 48, 49,

60, 77
microphone

location 15
product description 6

162 Index



microphone jack 23
microphone module

removal 121
spare part number 41, 48,

122
model description 67
model name 1
modem jack 24
modem module

removal 85
spare part number 37, 48, 85

modem, product description 6
monitor jack 24
mouse, spare part numbers 46,

47
mute light 20

N
network jack 24
num lk key 19
num lock light, location 20
numeric keypad 19

O
operating system applications

keys 18
operating system logo keys 18
operating system, product

description 10
optical drive

precautions 62
product description 6
removal 71
spare part numbers 38, 45,

49, 71
optical drive bay space saver,

illustrated 43
optical drive eject button 23

P
packaging guidelines 64
plastic parts, service

considerations 61
Plastics Kit

contents 43
spare part number 43, 54

pointing device, product
description 9

pointing stick 20
pointing stick button 20, 21

ports
1394 22
DisplayPort 23
eSATA 23
product description 8
USB 22, 23

power button 17
power connector 22
power cord

set requirements 158
spare part numbers 46, 47

power light 19, 21
power requirements, product

description 9
processor

product description 1
removal 114
spare part numbers 36, 49,

54, 56, 60, 114
product description

audio 6
chipset 2
display panel 4
Ethernet 6
external media cards 8
graphics 3
hard drive 5
keyboard 9
memory module 4
microphone 6
modem 6
operating system 10
optical drive 6
pointing device 9
ports 8
power requirements 9
processors 1
product name 1
security 9
serviceability 14
solid-state drive 5
upgrade drive 5
video 6
wireless 6

product description, flash cache 4
product name 1, 66
product number 66

R
rear components 24

removal/replacement
preliminaries 61
procedures 66

right-side components 23
RJ-11 jack 24
RJ-11 jack cable

illustrated 42
removal 98

RJ-11 jack plug, illustrated 43
RJ-45 jack 24
RTC battery

removal 76
spare part number 38, 48, 76

Rubber Kit, spare part number
37, 48

S
Screw Kit, spare part number 47,

54
security cable slot 24
security, product description 9
serial number 66
service considerations

cables 61
connectors 61
plastic parts 61

service cover
location 26
removal 70
spare part number 49
spare part numbers 39, 56,

70
service cover release latch 25
service cover release latch

assembly
removal 99
spare part number 99

service tag 28, 66
serviceability, product description

14
SIM, removal 69
Smart Card reader 22
Smart Card reader, spare part

number 54
solid-state drive

precautions 62
product description 5
spare part numbers 45, 55,

56, 60

Index 163



speaker assembly
removal 97
spare part number 36, 48, 97

speakers 22
specifications

computer 140
display 142
hard drive 143

system board
removal 106
spare part numbers 34, 53,

54, 55, 56, 106

T
tools required 61
top cover, spare part numbers

34, 53
TouchPad board cable, illustrated

42
TouchPad button 21
TouchPad components 20
TouchPad light 19
TouchPad on/off button 17, 20
TouchPad zone 20
transporting guidelines 64

U
upgrade bay

removal 73
spare part number 45, 73

upgrade bay, location 23
upgrade drive

product description 5
USB board

removal 117
spare part number 37, 117

USB port 22, 23

V
vents 24, 25
video, product description 6
volume mute button 18

W
warranty period 67
Web browser button 18
Web browser light 20
webcam 16
webcam light 15

webcam/microphone module
removal 121
spare part number 41, 53,

122
wireless antenna

removal 125, 126
spare part numbers 41, 48,

126
Wireless Antenna Kit, spare part

number 126
Wireless Antenna Kit, spare part

numbers 126
wireless antenna, locations 15
wireless button 17
wireless light 19, 21
wireless, product description 6
WLAN Antenna Kit, spare part

number 41, 48, 126
WLAN module

removal 82
spare part numbers 38, 47,

49, 56, 82
workstation guidelines 64
WWAN Antenna Kit, spare part

number 41, 48, 126
WWAN module

removal 80
spare part numbers 38, 49,

60, 80

164 Index




	Product description
	External component identification
	Display
	Buttons and fingerprint reader (select models only)
	Keys
	Lights
	TouchPad
	Front
	Left side
	Right side
	Rear
	Bottom

	Illustrated parts catalog
	Service tag
	Computer major components
	Display assembly subcomponents
	Cable Kit
	Plastics Kit
	Mass storage devices
	Miscellaneous parts
	Sequential part number listing

	Removal and replacement procedures
	Preliminary replacement requirements
	Tools required
	Service considerations
	Plastic parts
	Cables and connectors
	Drive handling

	Grounding guidelines
	Electrostatic discharge damage
	Packaging and transporting guidelines
	Workstation guidelines
	Equipment guidelines





	Component replacement procedures
	Service tag
	Computer feet
	Battery
	SIM
	Service cover
	Optical drive
	Upgrade bay
	Hard drive
	RTC battery
	Memory module
	WWAN module
	WLAN module
	Bluetooth module
	Modem module
	Fan
	Keyboard
	Base enclosure
	Speaker assembly
	RJ-11 jack cable
	Service cover release latch assembly
	Battery release latch assembly
	Function board
	System board
	Heat sink
	Processor
	USB board
	Display assembly


	Computer Setup (BIOS) and Advanced System Diagnostics
	Windows 8
	Using Computer Setup
	Starting Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup
	Updating the BIOS
	Determining the BIOS version
	Downloading a BIOS update


	Using Advanced System Diagnostics

	Windows 7
	Starting Computer Setup
	Using Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup

	Updating the BIOS
	Determining the BIOS version
	Downloading a BIOS update

	Using Advanced System Diagnostics

	SuSE Linux (SLED)
	Starting Computer Setup
	Using Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup

	Updating the BIOS
	Determining the BIOS version
	Downloading a BIOS update

	Using Advanced System Diagnostics


	Specifications
	Computer specifications
	14.0-inch SGA display specifications
	Hard drive specifications

	Backup and recovery
	Windows 8
	Backing up your information
	Performing a system recovery
	Using the Windows recovery tools
	Using f11 recovery tools
	Using Windows 8 operating system media (purchased separately)
	Using Windows Refresh for quick and easy recovery
	Remove everything and reinstall Windows
	Using HP Software Setup


	Windows 7
	Creating recovery media with HP Recovery Disc Creator
	Creating recovery media

	Backing up your information
	Performing a system recovery
	Using the Windows recovery tools
	Using f11 recovery tools
	Using a Windows 7 operating system DVD (purchased separately)


	SuSE Linux (SLED)
	Creating backups
	Backing up your information
	Performing a system recovery
	USB Recovery option (select models only)
	Remove everything and reinstall SLED


	Power cord set requirements
	Requirements for all countries
	Requirements for specific countries and regions

	Recycling
	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile ()
  /CalRGBProfile (ColorMatch RGB)
  /CalCMYKProfile (U.S. Sheetfed Uncoated v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.3
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket true
  /DefaultRenderingIntent /Default
  /DetectBlends false
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize false
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts false
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile (None)
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 2400
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check true
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError false
  /PDFXTrimBoxToMediaBoxOffset [
    36.00000
    36.00000
    36.00000
    36.00000
  ]
  /PDFXSetBleedBoxToMediaBox false
  /PDFXBleedBoxToTrimBoxOffset [
    14.40000
    14.40000
    14.40000
    14.40000
  ]
  /PDFXOutputIntentProfile (GWG_GenericCMYK)
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /SyntheticBoldness 1.000000
  /CheckCompliance [
    /PDFX3:2002
  ]
  /Description <<
    /ENU <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [14172.000 14172.000]
>> setpagedevice


